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Overview
This book is intended for the user who needs to become quickly familiar with Sketcher product. The Sketcher User's Guide has been designed to show you sketch 2D elements. This overview provides the following information: • • • • • Sketcher in a Nutshell Before Reading this Guide Getting the Most out of This Guide Accessing Sample Documents Conventions Used in this Guide

Sketcher in a Nutshell
Sketcher application 2D profiles. makes it possible for designers to sketch precise and rapid

Before Reading this Guide
Before reading this guide, you should be familiar with basic Version 5 concepts such as document windows, standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's Guide that describes generic capabilities common to all Version 5 products. It also describes the general layout of V5 and the interoperability between workbenches.

Getting the Most out of this Guide
To get the most out of this guide, we suggest you start reading and performing the step-by-step tutorial Getting Started. This tutorial will show you how to create a basic profile using SmartPick. The next sections deal with various types of profiles and associated operations as well as more details on constraints that can be applied to these profiles. You may also want to take a look at the Workbench Description sections describing the Sketcher menus and toolbars at the end of the guide.

Accessing Sample Documents
To perform the scenarios, sample documents are provided all along this documentation. For more information about this, refer to Accessing Sample Documents in the Infrastructure User's Guide.

Conventions Used in this Guide
1

sketcher To learn more about the conventions used in this guide, refer to the Conventions section.
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What's New?
No enhancements in this release.

3

Getting Started
Getting Started
Before getting into the detailed instructions for using the Sketcher workbench, this step-by-step tutorial aims at giving you a feel of what you can accomplish with the product. It will show you how to use some of the key functionalities. Thus, the Sketcher workbench provides a set of functionalities for creating, editing and setting constraints to sketched elements, such as curves and profiles. Moreover, from the Sketcher workbench, you can work on 3D elements, adding or editing 2D geometry to an existing part, for example. You will need a Version 5 session of CATIA. This tutorial should take about 20 minutes to complete. It will start with examples of how to enter the Sketcher workbench. A description of the interface will then help you get familiar with the basic commands. Once you are more familiar with the workbench, you will learn how to use the functionalities from both a 2D and a 3D perspective, by sketching first a new part and then an existing part.

Entering the Sketcher Workbench
This task lists the different ways of entering the Sketcher workbench before you start sketching. Thus you may want to: • • Create a new geometry using the Start menu bar. Create a new geometry using the File menu bar.

Creating a New Geometry, Using...
The Start Menu Bar
1. Select Start -> Mechanical Design -> Sketcher from the menu bar. 2. Select the reference plane in the geometry area.
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or 2. Select the reference plane from the specification tree.

The File Menu Bar
1. Select File -> New from the menu bar. The New dialog box is displayed. 2. Select Part from the New dialog box. If the Part name dialog box appears, select the options you need and validate by clicking OK. This dialog appears if you customized your session as explained in the Customizing chapter of the Part Design User's Guide. More precisely, refer to Part Document.

3. Click OK to validate. The Part Design workbench is displayed. 4. Select the reference plane in the geometry area or select the reference plane from the specification tree.
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5. Click the Sketch icon

from the Sketcher toolbar.

• •

The Sketcher workbench appears as shown here, with the main Sketcher toolbars displayed on the right hand side and at the bottom. Now, let's see more precisely the different Sketcher toolbars and how to restore their position.

Becoming Familiar with the Interface

7
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This task will show you how to quickly become familiar with the basic functionalities available within the Sketcher workbench. Before starting sketching, you may need to know how to: • • • Restore the toolbars' position. Use the Sketcher toolbars. Use the mouse buttons.

The Sketcher workbench is loaded.

Restoring the Toolbars' Positions
1. Select Tools -> Customize... from the menu bar. The Customize dialog box is displayed. 2. Click Restore position in the Toolbars tab. A dialog box is displayed asking you to confirm the Restore position action. 3. Click OK to validate. 1. Click Close in the Customize dialog box.
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All the Sketcher toolbars are now displayed at their appropriate positions as shown below:

Using the Sketcher toolbars
• to draw Predefined Profiles using the Profile toolbar.

•

to apply Constraints using the Constraint toolbar.
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•

to make Operations on profiles using the Operation toolbar.

•

to make Operation on both 2D and 3D geometry using the Tools toolbar.

Using the mouse buttons in order to...
select menus/commands/elements from the geometry area.
1. Click the left mouse button. 2. Select the desired element, for instance select a line from a rectangle.

multi-select elements from the geometry area
1. Click the left mouse button. 2. Select a first element. 3. Keep pressing the Ctrl key. 4. Select one after the other the wanted elements. or
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1. Press the left mouse button. 2. Drag the cursor over the elements to be selected. 3. Release the left mouse button. The wanted elements are selected.

Drag elements in the geometry area
1. Select an element from the geometry area. 2. Keep pressing the left mouse button. 3. Drag the mouse to move the selected element. or 1. Press the left mouse button. 2. Drag the cursor over the elements to be selected. 3. Move one of the rectangle line. As you can notice the whole rectangle is moving.
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Drag the whole geometry area
1. Keep pressing the middle mouse button. 2. Drag the cursor to move the whole geometry.

Re-center an indicated point
1. Click a point in the geometry area using the middle mouse button. The indicated point is moved to the center of the window.

zoom in and out
1. Keep pressing the middle mouse button. 2. Press the right mouse button once.
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3. Drag the cursor up to zoom in.

or 3. Drag the cursor down to zoom out.

Rotate elements in the geometry area
1. Keep pressing the middle mouse button. 2. Keep pressing the right mouse button. 3. Drag the cursor to rotate the geometry.
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Now that you have seen how to use the Sketcher toolbars and how to use the mouse button, let's start creating: • • sketches from new parts. sketches from existing parts.

Sketching from a New Part
Sketching from a New Part
In this section of the tutorial, you will learn how to sketch from a new part. You can also go directly to the second part of this tutorial and see how to Sketch from an Existing Part.

Create simple geometry: Shows how to create simple geometry such as a rectangle using basic options as the Snap to Point for instance. Apply constraints: Shows you how to quickly apply constraints on elements using either the Constraints toolbar or the Sketch toll toolbar. Analyze sketches: Shows you how to analyze a sketch using the Sketch Solving Status, the sketch Analysis or the Parent/Children options. Modify sketches: Lists the different ways of modifying or deleting elements from a
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sketch. Creating a pad: Shows you how to create a pad after exiting Sketcher.

Creating Simple Geometry
This task will show you how to create a geometry using such options as the Snap to Point, the SmartPick or the Standard/Construction Elements. To create simple geometry, you need to get familiar with such option as: • • • Using the Snap to Point. Using the Smart Pick. Creating Standard/Construction Elements.

Using the Snap to Point Option
The Snap to Point option is activated by default.

1. Make sure the Snap to Point option is activated. 2. select the Rectangle icon from the Profile toolbar.

3. Drag the cursor to define the rectangle dimensions.

As you are sketching the points are snapped to the intersection points of the grid. If this option is not activated, your sketch is not influenced by the grid points.
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Using the Smart Pick
• • • The SmartPick helps you detecting the constraints all along the sketch creation. For instance, here a coincidence constraint is detected during the rectangle creation with the H direction. The SmartPick is directly linked to the options that have been checked in the Tools -> Options dialog box. Therefore, if you do not wish to visualize the constraints detected by the SmartPick, then simply uncheck the appropriate options in the Smart Pick dialog box by selecting Tools -> Options -> Mechanical Design -> Sketcher -> SmartPick. When the Smartpick detects a coincidence between a line and a point, is visualized in the geometry. this symbol When the Smartpick detects a coincidence between two points, this symbol is visualized in the geometry.

• •
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Using the Construction/Standard Elements Option
• • Once set to the Construction mode, elements can not be published in the 3D area. Standard Elements are created by default and they can be published in the 3D area.

The Construction/Standard Element option

is not active by default.

1. Create a rectangle as the one shown above. 2. Select the Corner icon from the Operation toolbar.

3. Select the Trim all Elements option from the Sketch tools toolbar. 4. Select the two parallel lines one after the other.
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An arc of circle is displayed and you can position it as you like just by dragging the cursor. 5. Drag the cursor to position the corner as shown here. 6. Click in the geometry to finish the corner creation.

• •

Note that the corner is created and that the two selected lines have been re-limited automatically. The corner is created and as the Construction/Standard Element option is not activated, the elements of this sketch are set to the standard mode.

7. Select the rectangle line as shown here.

18

Getting Started

8. Click the Construction/Standard Element tools toolbar.

option from the Sketch

• •

The selected line has been swapped to construction mode and is displayed as shown here. If you want to generate a pad from this sketch it is important to set the line in construction mode otherwise the pad generation will not be possible. To swap it back to the standard mode, simply select it and click again the Construction/Standard Element.

•

•

Note that this is only one way of creating this sketch and that you can get the same result using other commands such as the Profile, the Circle, etc... When setting an element in construction mode, then this element is not published once in the 3D area

•
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Applying Constraints
This task will show you how to quickly apply constraints to a sketch elements. To do so, you have two possibilities either: • • Using the Sketch tools toolbar. Using the Constraint toolbars.

Using the Sketch Tools Toolbar
• • •

The Geometrical and Dimensional Constraints options are activated by default. The Geometrical Constraint displays all detected geometrical constraints. The Dimensional constraint only displays distance constraints when the option is activated.

1. Create a rectangle with a corner.

Geometrical Constraint
You will get a geometry which looks like this.

2. Keep only the Geometrical Constraint activated. 3. Click the Circle icon toolbar. from the Profile
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4. Select the corner center to define the one of the circle. 5. Drag the cursor to define the circle dimensions. 6. Click in the geometry when you are satisfied with the dimensions.

• •

The circle is created and the geometrical constraints have been detected. This constraints can be visualized either in the geometry area or in the specification tree.

Select the circle and move it to see the tangency constraint is well applied. 9. Right-click the construction line. 10. Select Delete from the contextual menu. The construction line has been deleted as long as its associated geometry.

Dimensional constraint
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2. Keep only the Dimensional Constraint activated. 3. Click the Circle icon toolbar. from the Profiles

4. Select the corner center to define the one of the circle. is displayed by the SmartPick Note that this symbol as a coincidence between two points is detected.

The Sketch tools toolbar expands.

5. Enter a radius value, for instance 20mm. 6. Press Enter. The dimensional constraint is displayed in the geometry.

Note that if you want to keep the dimensional constraints displayed, the Dimensional Constraint op activated.

Using the Constraints Toolbar
22
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1. Keep your sketch open. 2. Select the rectangle top line. 3. Click the Constraint icon from the Constraints toolbar. 4. Click in the geometry to create the constraint.

5. Select the rectangle left hand side line. 6. Click the Constraint icon from the Constraints toolbar. • • The geometry color is swapped to the purple color which means that it is over constraint. You can use the Sketch analysis to have a diagnosis the over-constraint elements. This option will be seen later on in this tutorial in the Analyzing Sketches section which comes next.

7. Click in the geometry to create the constraint.

8. Right-click the Radius constraint. 9. Select Delete from the contextual menu. The constraint is deleted and the geometry is no longer over-constrained.

23

sketcher

You can also set constraints using the Constraints available in the Defined in Dialog Box icon Constraint toolbar and select the constraint(s) you wish to apply in the Constraints Definition dialog box.

Analyzing Sketches
This task shows how to apply an analysis on a sketch through different means such as by: • • • Using the Parents/Children Using the Sketch Solving Status Using the Sketch Analysis

In case you did not save the previous sketch, open the Getting_Started.CATPart document.
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Using the Parents/Children
1. Right-click the tangency constraint from the specification tree. 2. Select Parents/Children contextual command. • • • The Parents and Children dialog box is displayed. The elements to which the selected constraint is related are shown within the dialog box. If you wish to see more details on the parents (here the circles), just double-click one of the element in the dialog box.

3. Click OK in the dialog box.

Using the Sketch Solving Status
1. Select the corner. 2. Click the Constraints Defined in Dialog Box icon Constraints toolbar. The Constraint Definition dialog box is displayed. 3. Select the Radius / Diameter option. The geometry color has turn to purple meaning that it is overconstrained. from the
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4. Click anywhere outside the geometry to validate the constraint creation. 5. Click the Sketch Solving Status icon the Tools toolbar. from the 2D Analysis Tools in

This command gives you a quick diagnosis of the geometry status.

•

•

The Sketch Solving Status dialog box is displayed and informs you of the general sketch status, whether it is under, over or iso-constrained. Meanwhile, the information given in the Sketch Solving Status dialog box is highlighted in red in the geometry area and the element that are here under-constrained are highlighted.
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Using the Sketch Analysis
The Sketch Solving Status dialog box is still displayed.

1. Click the Sketch Analysis option Status dialog box.

available from the Sketch Solving
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•

The Sketch Analysis dialog box is displayed and information is given on every element of the sketch as long as the created constraints in the diagnostic tab. Construction elements appear with a blue color in the geometry. Note that you have the possibility to sort the elements displayed in the dialog box by Name, status or Type, by clicking the appropriate tab. Note that you can select elements from the dialog box and they will be highlighted in the geometry area.

• •

•

Note that you can now identify the construction elements and, for instance, swap them into standard elements.

2. Select the Hide Construction Geometries icon Analysis dialog box.

from the Sketch
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• •

All the construction elements are hidden both from the dialog box and the geometry area. These elements are grayed in the specification tree.

3. Select the Hide Constraints icon box.

from the Sketch Analysis dialog
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• •

All the constraints are hidden both from the geometry and the dialog box. These elements are grayed in the specification tree.

Note that the green color shows you the whole geometry is now constrained. For more details on the Sketch analysis command, see Analyzing the sketch.

Modifying Sketches
This task shows how to use the Undo/Redo option or delete elements.

30
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Using the Undo/Redo Command
1. Click the Circle from icon the Profile toolbar. 2. Position the cursor until the SmartPick detects a constraint as shown here. 3. Click in the geometry and drag the cursor to create the circle. • Note that when SmartPick cursor crosses a fictitious horizontal line that would go through a point, SmartPick snaps in order to remain horizontal to this point. • In this case no constraint is created.
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•

If you are not satisfied with your sketch, click the Undo icon from the Standard toolbar to go back in your sketch history creation. If you have been too far in your sketch history creation, click the Redo icon from the Standard toolbar to go ahead in your sketch creation.

•

Deleting elements
4. Double-click the Quick Trim icon , to make it permanent, from the Relimitations sub-toolbar in the Operation toolbar.
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5. Select the line within the circle. A warning is displayed informing you that dimensional constraints cannot be deleted. 6. Click Yes in the dialog box.

7. Select the circle from the part outside the rectangle. • The selected line and a circle part are deleted from the geometry. Note that the place where you select the geometry to be deleted is important as it is the exact part that will be deleted. You can also use the contextual menu to delete elements.

•

•

Creating a Pad
This task shows you how to exit the Sketcher workbench in order to create a pad.
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In case you did not save the previous sketch, open the Getting_Started.CATPart document.

1. Select the Exit Workbench from the icon Workbench toolbar. Your sketch is displayed in the Part Design workbench. 2. Click the Pad icon .

The Pad Definition dialog box is displayed and a pad preview is shown in the geometry area. 3. Enter 25 in the Length field. 4. Click OK to validate the pad creation.
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The pad is created as shown here.

• •

You can use the Sketch icon to edit a sketch from the Pad Definition dialog box. It is also possible to position a sketch from the Part Design workbench, see Creating a Positioned Sketch.

Sketch Absolute Axis

Now, outside the Sketcher, for example in Part Design or in Generative Shape Design, you can hi show your sketch absolute axis. To do so, you just need to select the absolute axis or one of its s elements (origin, H or V direction) either in the specification tree or in the 3D Area. Then, use the Hide/Show contextual menu item or more quickly, click the Hide/Show icon available in the toolbar. For more information about that command, refer to the Infrastructure User's Guide.
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Sketching from an Existing Part
Sketching from an Existing Part
In this section of the tutorial, you will learn how to sketch from an existing part. You can also back directly to the first part of this tutorial and see how to Sketch from a New Part.

Create a positioned sketch: Shows you how to position a sketch according to a given surface of an existing part. Use the normal view option: Swaps to the normal view of the current document. Cut the part by the sketch plane: Cuts the part according to a selected plane so that some edges are made visible to help the sketch creation. Set the datum mode: Creates geometry with the History mode deactivated. Create an output feature: Creates elements which can be published and updated in the 3D area independently from the whole sketch.

Creating a Positioned Sketch
This task shows you how to position a sketch by selecting a surface from an existing part. To do so this scenario is divided into five parts: • • • • • Positioning the Sketch Creating the sketch Constraining the Sketch Generating a Pad Creating a Pocket

Positioning the Sketch
If it is not displayed, open the Getting_Started1.CATPart document.
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Note that the part appears in the Part Design workbench.

1. Select the Positioned Sketch icon

from the Sketcher toolbar.

The Sketch Positioning dialog box is displayed.

2. Keep the Positioned option selected.
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3. Select Plane.2 either from the specification tree or the geometry area. 4. Specify the reference plane for the sketch as shown here. The Reference field now indicates the reference plane and the Type fields of the Origin and Orientation areas are now activated. 5. Select Curve intersection in the Type field of the Origin area. 6. Select the part cylindrical surface to make its axis intersect with the absolute axis origin.

7. Select Parallel to line in the Type field of the Orientation area. 8. Select the Output as shown here.
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9. Click OK in the Sketch Positioning dialog box.

Creating the Sketch
You get automatically in the sketcher workbench and you are ready to sketch a profile.
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1. Click the Axis icon

from the Profile toolbar.

2. Create an axis as shown here.

3. Create a circle. 4. Click the Profile icon from the Profile toolbar.

5. Start drawing the profile in order to get a sketch like the one shown here.

40

Getting Started

To create the arc of circle using the Profile command, simply keep holding the left mouse button between the arc of circle first and end points.

Constraining the Sketch
1. Multi-select the arc of circle center and the circle. 2. Click the Constraint Defined in Dialog Box icon Constraint toolbar. The Constraint Definition dialog box is displayed. from the
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3. Select Coincidence option in the dialog box. 4. Click OK. The constraint has been applied as shown above.

Generating the Pad
1. Click the Exit Workbench icon from the Workbench toolbar.

You are now back in the Part Design workbench and the sketch is displayed.

2. Click the Pad icon

.

The Pad Definition dialog box is displayed. 3. Enter 10 in the Length field. 4. Right-click in the Selection field and click Go to profile definition contextual command The Profile Definition dialog box is displayed. 5. Select Edge.3 from the geometry area.
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The Profile Definition dialog box is updated with the selected sketch.

6. Click OK in the Profile Definition dialog box. A warning dialog box is displayed to inform you that the profile is not valid. 7. Click OK in the Warning dialog box. 8. Click the Reverse Side command to change its direction and solve the problem. The profile is displayed as shown here.
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The normal is now well positioned. 9. Click ok in the Pad Definition dialog box to validate the pad creation.

Creating a Pocket
1. Click the Pocket icon .

The Pocket Definition dialog box is displayed.
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2. Right-click the Selection field. 3. Click Go to profile definition.

The Profile Definition dialog box is displayed. 4. Select the circle from the geometry area. 5. Click the arrow to have it displayed upwards. The Profile Definition dialog box is updated with the selected element.

6. Click OK in the Profile Definition dialog box. The Pocket Definition dialog box is displayed back. 7. Keep the Up to Last option selected. 8. Click ok in the Pocket Definition dialog box to validate the creation.
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The pocket is created as shown here.

• •

The pad has been created and its lines have been automatically relimited so that it is tangent with the first part. To have more details on the Sketch positioning option see Creating a Positioned Sketch.

Using the Normal View
Now that you have positioned your sketch, this task will show you how to display the normal view the current view. Note that the part appears in the Part Design workbench.
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1. If it is not displayed, open the Getting_Started1.CATPart document. 2. Double-click Sketch.2 from the geometry. The sketch is displayed in the Sketcher Workbench.

To Restore the Original View
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1. Move the part to visualize the hidden part pieces. 2. Click the Normal View icon from the View toolbar.

The part position has been restored.

To Visualize the Opposite Part Side
• Click the Normal View icon from the View toolbar.
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The part is moved so that the normal view to the current view is displayed. If you wish to go back to the original view, just click again the Normal View icon .

Cutting the Part by the Sketch Plane
This task will show you how to cut a part by a sketch plane so that some edges are made visible. Thus, the sketch plane view is simplified as pieces of material which you do not need for sketching are hidden. Note that the part appears in the Part Design workbench.
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1. If it is not displayed, open the Getting_Started1. CATPart document. 2. Double-click Sketch.2 from the geometry. The sketch is displayed in the Sketcher Workbench.
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3. Move the sketch so that you can see the whole part.

4. Click the Cut Part by Sketch Plane from the icon Visualization toolbar.
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•

•

•

A piece of material has been hidden and some edges are now visible, which can let you now sketch the required profile taking these edges into account. To display the cut part again, simply click the Cut Part by Sketch Plane icon again. For more information on the Cut Part by Sketch Plane option, see Cutting the Part by Sketch Plane.

Setting the Datum Mode
This task will show you how to create a geometry with the History mode deactivated, which means that for each created element there are no links to the other entities that were used to create that element. Note that the part appears in the Part Design workbench. 1. If it is not displayed, open the Getting_Started1.CATPart document. 2. Click the Pad icon .

The Pad Definition dialog box is displayed. 3. Click the Sketch icon from the Pad Definition dialog box.

4. Select Plane.2 either from the geometry area or the specification tree.
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You are now in the Sketcher Workbench.

5. Click the Create Datum icon the History mode.

from the Tools toolbar to deactivate

6. Select the internal cylindrical surface of the part as shown here.

7. Select the Project 3D Elements icon The projection is created. 8. Select the Exit Workbench icon • •

from the Operation toolbar.

from the Workbench toolbar.

You are now back in the Part Design workbench. Both the part and the dialog box are still displayed.

9. Set the length value. 10. Check the Mirrored extend option. The part will be displayed as shown here based on the newly created Sketch.3.
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11. Click OK in the Pad Definition dialog box. The pad has been created and now edit Sketch.1.
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12. Double-click Sketch.1 from the specification tree. You are now back in the sketcher workbench. 13. Double-click the smallest circle radius value from the geometry. The Constraint Definition dialog box is displayed. 14. Change the radius value to 70mm for instance.
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15. Click OK in the dialog box. The created pad has not been updated as elements created with the Datum mode activated are no longer associative the other geometry.
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Note that: • • • the associativity between elements is no more kept when using the Datum mode. this option has the same effect when using the Offsetting a use-edge element. a click on the icon activates the Datum mode for the current or the next command.

Modifying an Output Feature
This task will show you how to modify an output feature from 3D elements. Note that the part appears in the Part Design workbench. 1. If it is not displayed, open the Getting_Started1.CATPart document. 2. Double-click the Sketch.2 from the geometry. The sketch is displayed in the Sketcher Workbench.
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3. Select the Output.1 from the specification tree to have it highlighted in the geometry area. This output is based on Line.2 4. Set the Angle.26 value to 90 deg. This constraint affects the Output.1 orientation. 5. Click the Exit Workbench icon from the Workbench toolbar.

You are now back in the Part Design workbench and the sketch is displayed.
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For more details on Output Features creation, see Creating Output Features.
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Before You Begin
Before You Begin
Before you begin, you should be familiar with the following tools and concepts that will help you in: • • • creating simple or predefined profile with or without using SmartPicking. editing or performing operations on these profiles. adding constraints on profiles.

Use tools: Use the Sketch tools toolbar displayed in the bottom right part of the software screen which provides helpful options Use colors: Use colors to define either graphical properties or constraint diagnostics. Cut the part by the sketch plane: Hide the portion of part you do not want to see in the Sketcher. Converting standard into construction elements: Assign a new type of a line to an element for differentiating construction from non construction elements.

Using Tools For Sketching
This task shows how the software can assist you when sketching elements. The Sketch tools toolbar is displayed in the bottom right part of the software screen and provides the following options commands:

Working with the Grid Option Working with the Snap to Point Option Creating Construction/Standard Elements
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Creating Geometrical Constraints Creating Dimensional Constraints Value Fields You do not necessarily visualize the whole Sketch tools toolbar. Just undock it to display all the available options and fields.

Working with the Grid Option
The Grid option is now directly available from the Sketch tools toolbar. Clicking the icon displays the grid in your session. The grid spacing and graduations are Grid defined using the Tools -> Options -> Mechanical Design -> Sketcher command. For more information, refer to Customizing.

Working with the Snap to Point Option
If activated, this option makes your sketch begin or end on the points of the grid. As you are sketching the points are snapped to the intersection points of the grid. Note that this option is also available in the Tools->Options, Mechanical Design -> Sketcher option at the left of the dialog box (Sketcher tab). For more information, see Infrastructure user's guide (Customization Settings). In the following example: • • the black spline was created with Snap to Point on. The points are on the grid. Conversely, the here highlighted spline was created with the Snap to Point option deactivated.
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Note that when you zoom in, snapping option remains active both on primary and secondary grids, even though the secondary grids are not visualized any more. When SmartPick is active, points may not snap at the intersection points of the grid. Care that they will necessarily snap on an horizontal or a vertical grid subdivision. The SmartPick capability works even if this option is on.

Creating Construction/Standard Elements
You can create two types of elements: standard elements and construction elements. Note that creating standard or construction elements is based upon the same methodology. If standard elements represent the most commonly created elements, on some occasions, you will have to create a geometry just to facilitate your design. Construction elements aim at helping you in sketching the required profile. option command from the Sketch 1. Click the Construction/Standard Element tools toolbar so that the elements you are now going to create be either standard or construction element. As construction elements are not taken into account when creating features, note that they do not appear outside the Sketcher.
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• •

When they are not used anymore, construction elements are automatically removed. Note that in the case of hexagons, construction element type is automatically used for secondary circles. This type of sketch is interesting in that it simplifies the creation and the ways in which it is constrained. Setting a radius constraint on the second circle is enough to constrain the whole hexagon. Just imagine what you would have to do to constrain hexagons sketched with no construction circles!

Creating Geometrical Constraints
When selected, the Geometrical Constraint option command allows forcing a limitation between one or more geometry elements.

Creating Dimensional Constraints
When selected, the Dimensional Constraint option command allows forcing a dimensional limitation on one or more profile type elements provided you use the value fields in the Sketch tools toolbar for creating this profile. To know more about sketcher constraints, please refer to Setting Constraints, and Infrastructure user's guide (Customization Settings).

Value Fields

The values of the elements you sketch appear in the Sketch tools toolbar as you move the cursor. In other words, as you are moving the cursor, the Horizontal (H), Vertical (V), Length (L) and Angle (A) fields display the coordinates corresponding to the cursor position.
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•

• • • •

You can select the desired field of the Sketch tools toolbar and type in the desired values: o Using the mouse cursor. o Using the Tab key. You can increment or decrement the value in a field using the Up key or Down key according to the grid options. When you select another field, the value in the previously selected filed is locked. Type any number fill by default the first field. Press Enter to validate your values.

You can also use these fields for entering the values of your choice. In the following scenario, you are going to sketch a line by entering values in the appropriate fields. 1. Click the Line icon.

The Sketch tools toolbar displays information in the four value fields. 2. Enter the coordinates of the First Point. 3. Enter the coordinates of the Second Point. or 2. Enter the length (L) of the line. 3. Enter the value of the angle (A) between the line to be created and the horizontal axis. 4. Click the first point on the line. The line is created. Depending on the number of fields available and the way you customize your toolbars, some fields may be truncated. What you need to do is just undock the Sketch tools toolbar.

Using Colors
Two types of colors may be applied to sketched elements. These two types of colors correspond to colors illustrating: • Graphical properties Colors that can be modified. These colors can therefore be modified using the contextual menu (Properties option and Graphic tab).

OR
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•

Constraint diagnosis Colors that represent constraint diagnostics are colors that are imposed to elements whatever the graphical properties previously assigned to these elements and in accordance with given diagnostics. As a result, as soon as the diagnostic is solved, the element is assigned the color as defined in the Properties dialog box (Graphic tab).

COLORS and GRAPHICAL PROPERTIES

Grey: Construction Element
Elements that are internal to, and only visualized by, the sketch. These elements are used as positioning references. These elements cannot be visualized in the 3D and therefore cannot be used to generate solid primitives.

Yellow: Non Modifiable Element
For example, use edges. These elements cannot be modified, graphically speaking.

Red Orange: Selected Element
A subgroup of elements actually selected (the Select icon is similarly active).
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COLORS and DIAGNOSIS

SOLUTION:

White: Under-Constrained Element
The geometry has been constrained: all the relevant dimensions are satisfied but there are still some degrees of freedom remaining. Add constraints.

Brown: Element Not Changed
Some geometrical elements are over-defined or notconsistent. As a result, geometry that depend(s) on the problematic area will not be recalculated. Remove one or more dimensional constraints.
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Green: Fixed Element The geometry has been fixed using the Constraint Definition dialog box or the contextual menu (right mouse button).

Green: Iso-Constrained Element All the relevant dimensions are satisfied. The geometry is fixed and cannot be moved from its geometrical support. Geometry before and after being moved:
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Purple: Over-Constrained Element The dimensioning scheme is overconstrained: too many dimensions were applied to the geometry. Remove one or more dimensional constraints.

Red: Inconsistent Element At least one dimension value needs to be changed. This is also the case when elements are underconstrained and the system proposes values by defaults that do not lead to a solution.

Add dimensions. Set dimension value(s) properly.

Inconsistent and Over-Constrained Elements: When leaving the sketcher, the software will only generate a warning for inconsistent and over-constrained elements if they belong to a sketch issued from the release 5 or releases before. Since release 6, the software generates an error.

Cutting the Part by the Sketch Plane
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sketcher This task shows how to make some edges visible. In other words, you are going to simplify the sketch plane view by hiding the portion of material you do not need for sketching. Open the Intersection_Canonic.CATPart document. 1. Select the plane on which you need to sketch a new profile and enter the Sketcher workbench.

Once in the Sketcher, you obtain this view, which does not show the edges you want to see.

2. Click the Cut Part by Sketch Plane icon on the Visualization toolbar to hide the portion of part you do not want to see in the Sketcher.

• •

You obtain this view without the material existing above the sketch plane. The edges corresponding to the shell are now visible. The edges resulting from the intersection are not visualized and therefore cannot be selected.
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3. You can now sketch the required profile taking these edges into account.

Defining a Visualization Mode
This task shows you how to set the visualization mode that best meets your needs. The Sketcher provides three options: • • • Usual Low Light No 3D Background

Behavior Common to the Three Modes
Whatever mode you choose, you can always: • • access and select features in the specification tree even when the 3D background is not visualized. When editing a sketch, the visualization mode you defined for it is retrieved.
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Working with the Usual Option
The Usual mode is the default option. When activated, the 3D geometry is visible in the Sketcher.

Working with the Low Light Option
If activated, the Low Light mode introduces a low light for all geometrical elements and features that then appear as gray-colored, except for the current sketch. Additionally, although you can see them, you cannot select them. You can just handle Sketcher elements.

Working with the No 3D Background Option
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Converting Standard into Construction Elements
This task shows how to convert standard elements into construction elements and vice versa. Open the Construction_Standard.CATPart document. 1. Select the line (standard type) you wish to convert into a construction line.

2. Click the Construction/Standard Element option tools toolbar.

from the Sketch

The line you previously selected appears dashed to show it is a new type of line.
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3. Click the Construction/Standard Element option

again.

The construction line is converted into a standard line.

Double-clicking on the line displays the Line Definition dialog box in which you can un-check the Construction element option if you want to convert the construction line into a standard line. For more information, refer to Modifying Element Coordinates. • In certain cases, construction elements are automatically created (e.g. when offsetting canonical elements, or when creating lines normal to a curve). If you subsequently delete the constraint or one of the elements, the construction element will be automatically removed. Construction lines are not taken into account when entering another workbench. Applying the Construction/Standard Element has no effect. option on axes

• •

Entering the Sketcher Workbench
This task lists the different ways of entering the Sketcher workbench. To create a sketch, you have several possibilities: • • Select Start -> Mechanical Design -> Sketcher from the menu bar. and specify the reference Select the Sketch with Positioned Sketch icon plane, and the origin and orientation of the axis system. This enables you to create a positioned sketch.
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This is the recommended method for creating a sketch, as it enables you to define explicitly the position of the axis system and ensures associativity with the 3D geometry. • and click the desired reference plane either in the Select the Sketch icon geometry area or in the specification tree, or select a planar surface. This creates a "non-positioned" sketch (i.e. a sketch for which you do not specify the origin and orientation of the absolute axis, which are not associative with the 3D geometry). The sketch absolute axis may "slide" on the reference plane when the part is updated.

•

Select one plane of the axis system. h and v are aligned to the main axes of this selected plane. Associativity is kept between both the plane and the sketch.

HV plane calculation in relation to selected plane: • • • The normal of the working support is the same as the principal normal of the plane selected. You choose zx plane, the PRINCIPAL NORMAL is Y The first vector H is define as follow : H= Z x N ( x means vectorial product). N is the normal vector y in our case. H = -X. The second vector V is define as V = N x H Don't forget that H;V;N must make a direct trihedron. You can reorient the axis system in the work support but the axis system must be direct. So when changing one vector H, change the others too.

Orientation
Remember that depending on the plane you choose for your sketch, HV directions differ as follows: • • if the plane is selected from a user-defined axis system, h and v are aligned to the main axes of this selected plane. otherwise, the sketch is positioned in relation to the origin of the part.

The Sketcher workbench appears as follows:
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Entering the Sketcher to edit an Existing Sketch
To edit an existing sketch, you have several possibilities: • • Double-click the sketch or an element of the sketch geometry, either in the geometry area or in the specification tree. To do this from the 3D area, right-click the sketch in the specification tree, point to [sketch name] object in the contextual menu, and then select Edit.

Adding a Grid
To help you sketch your geometry, the application lets you add a grid. To know how to define and display a grid, Click here.

Creating a Positioned Sketch
In this task, you will learn how to create a positioned sketch, in which you specify the reference plane, and the origin and orientation of the absolute
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axis. Creating a positioned sketch enables you to define (and later change) explicitly the position of the sketch absolute axis. This offers the following advantages: • • You can use the absolute axis directions like external references for the sketched profile geometry. When the geometry of the part evolves and the associated position of the sketch changes, the shape of the sketched profile (2D geometry of the sketch) remains unchanged (even if the sketched profile is underconstrained).

Creating a positioned sketch also ensures associativity with the 3D geometry. Open the Positioned_sketch.CATPart document. You will now create a positioned sketch that will enable you to design the retaining bracket for this part. You will position the sketch absolute axis as follows: • • • its origin will be on the axis of revolution, its horizontal (H) direction will be parallel to the flat face, its vertical (V) direction will be normal to the flat face.

1. Click the Positioned Sketch icon: The Sketch Positioning dialog box appears.
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In the Type field in the Sketch Potisioning area, two options are available: • • Positioned (pre-selected): creates a positioned sketch for which you specify the origin and orientation of the absolute axis. Sliding: creates a "non-positioned" sketch, i.e. a sketch for which you do not specify the origin and orientation of the absolute axis. This option is mainly used for compatibility with non-positioned sketches, and to enable you to turn them into positioned sketches. With the Sliding option, the sketch absolute axis may "slide" on the reference plane when the part is updated.

2. Keep the Positioned option selected. You will now specify the reference plane for the sketch. 3. Make sure the Reference field is active, and select the blue surface (Shaft.1).
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The Sketch Positioning dialog box is updated: the Reference field now indicates the reference plane. Also, the Type fields of the Origin and Orientation areas are activated and the Implicit mode is pre-selected. With the Implicit mode, the sketch origin point and the sketch orientation are positioned according to the geometry used for the sketch plane: • When the sketch support is a plane, the sketch origin point is a projection of the part origin point in the sketch plane, and the sketch orientation is parallel to the reference plane directions. When the sketch support is defined by two secant lines, the origin is at the intersection of these. The H direction is co-linear to the first line, and its orientation directly depends on the orientation of this line. The V direction is deduced from the second line, which is not necessarily orthogonal to the first line. This second line simply defines, depending on its orientation, the side where the V direction will be positioned in relation to the H direction.

•
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You will now specify the absolute axis origin so to make it coincident with the axis of revolution of the part. 4. select Curve intersection in the Type field of the Origin frame. The Reference field is activated.

5. Select the cylindrical surface to make its axis intersect with the absolute axis origin.

80

User Tasks

The absolute axis of the sketch is now positioned on this axis. Its orientation has not changed.

You will now specify the absolute axis orientation according to an edge of the flat face. 6. Select Parallel to line in the Type field of the Orientation frame. The Reference field is activated.
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7. Select an edge of the flat face.

The absolute axis of the sketch is now oriented like the selected edge.
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You will now invert the H direction and make the V direction normal to the flat face. To do this, start by selecting V Direction in the Orientation area to specify that you want the orientation to be defined according to the V direction. 8. Select the Reverse V box to revert the V direction and select the Swap box to swap H and V directions.

The sketch is now positioned as wanted.
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9. Click OK to validate and exit the Sketch Positioning dialog box. You are now in the Sketcher workbench and ready to sketch a profile for the retaining bracket.

•

•

•

The absolute axis (its origin point, both its directions and the grid) can be used to specify the position and dimensions of the 2D geometry because it is associative with the part. With positioned sketches, the origin and directions of the absolute axis are similar to external references (Use-Edges) obtained using additional projections or intersections when creating non-positioned sketches. In this exercise, you did not create any constraints on 2D geometry: the geometry is under-constrained. Yet, if you move
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•

or resize the part (no matter how significantly), the profile you sketched will remain absolutely unchanged. Its shape will not be altered: thanks to the fact that the position of its absolute axis is explicitly defined, it is automatically pre-positioned in 3D before its 2D resolution. At any time after creating a positioned sketch, you can change the reference plane, the origin and the orientation of the absolute axis by specifying the new geometry in the associated Reference field. To do this from the 3D, right-click the positioned sketch in the specification tree, point to [sketch name] object in the contextual menu, and then select Change sketch support.

Changing a Sketch Support
This task shows you how to change the position of a sketch by changing its support. Changing a sketch support amounts to editing the absolute axis definition of the sketch. Open the Change_Sketch_Support.CATPart document. In this scenario, you will edit the absolute axis definition of Pocket.2/Sketch.3 by making it associative to Pocket.1. This will ensure that, when moving Pocket.1, Pocket.2 follows Pocket.1 without requiring you to edit the geometry of Sketch.3. 1. From the specification tree, right-click Sketch.3.

2. In the contextual menu which is displayed, select Sketch.3 object -> Change Sketch Support.... If a message appears, informing you that if you change its position, the sketch may become inconsistent or over-constrained, simply click OK. The Sketch Positioning dialog box appears.
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3. If the Move Geometry option at the bottom of this dialog box is checked, uncheck it. This will prevent the geometry from moving when performing the next operations in the dialog box. In the Type field in the Sketch Support area, three options are available: o o

o

Positioned: positions the sketch using the origin and orientation of the absolute axis Sliding: default type used for non-positioned sketches (i.e. when you edit a nonpositioned sketch, this option will be selected by default, as is the case in our example). This option is mainly used for compatibility purposes, and to enable you to turn non-positioned sketches into positioned ones. With the Sliding option, the sketch is not positioned, i.e. the origin and orientation of the absolute axis is not specified. As a result, its absolute axis may "slide" on the reference plane when the part is updated. Isolated: isolates the sketch in order to break all absolute axis links (support, origin and orientation links) with the 3D or to solve update errors. Only the 3D position wil be kept, to ensure that the sketch does not move. With the Isolated option, you cannot define the sketch support, origin and orientation.

4. Select the Positioned option, and make sure Pad.1/Face is selected as the reference element for the sketch support (Reference field). 5. At this point, check the Move Geometry option to specify that, from now on, the geometry should be moved when the sketch position is modified. 6. Check the Swap box to swap H and V directions. The new sketch position is previewed in the geometry area.
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7. You are now going to make the absolute axis associative with Pocket.1. 7. Uncheck the Move Geometry option once again to ensure that the geometry does not move according to the newly defined axis. 8. In the Type field in the Origin area, select Intersection 2 lines. 9. You will now specify the reference element for the origin. To do this, make sure the Reference field is active, and select a horizontal edge of Pocket.1 as shown below.

10. Now, select a vertical edge of Pocket.1 as shown below.
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11. In the Orientation areas, leave the Type field set to Implicit and the Reference field set to No Selection. For more information on the other options available in the Origin and in the Orientation areas, refer to Creating a Positioned Sketch in the Sketcher User's Guide. 12. Click OK. The absolute axis definition of Sketch.3 is modified and the position of the pocket is changed.

13. From the specification tree, double-click Sketch.2 to edit it.

14. On the sketch, double-click the value of Offset.57.
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15. In the Constraint Definition dialog box which is displayed, enter a new value, 90 for example, and click OK. The constraint is updated, and Sketch.2 is moved accordingly.

16. Exit the Sketcher workbench. As you can see, Pocket.1 has been moved, and Pocket.2 is still positioned according to the absolute axis you defined for Sketch.3.

17.
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Setting Constraints
Setting Constraints
You can set geometrical and dimensional constraints on various types of elements. Before you Begin: You should be familiar with important concepts. Create Quick Dimensional/Geometrical Constraints: Set constraints on elements or between two or three elements. The constraints are in priority dimensional. Use the contextual menu to get other types of constraints and to position this constraint as desired. Define Constraint Measure Direction: Define the measure direction as you create a dimensional constraint. Create Contact Constraints: Apply a constraint with a relative positioning that can be compared to contact. You can either select the geometry or the command first. Use the contextual menu if you want to insert constraints that are not those created in priority. Modify Constraint Definition: Double-click a constraint and modify the definition using the Constraint Definition dialog box. Create Constraints Using a Dialog Box: Set various geometrical constraints between one or more elements using a dialog box and if needed, multiselection. Modify Constraints on/between Elements: Edit geometrical constraints defined on elements or between elements either in the Sketcher or in the 3D area. Fixing Elements Together: Select the geometry to be attached and click the icon. Auto-Constrain a Group of Elements: Detects possible constraints between selected elements and imposes these constraints once detected. Animate Constraints: Assign a set of values to the same angular constraint and examine how the whole system is affected. Edit Multi-ConstraintS: Click the icon and enter new values for the dimensional constraints displayed in the dialog box that appears. Analyze and Resolve Over-Constrained or Inconsistent Sketches

Before You Begin
What is SmartPick?
SmartPick is an intuitive, easy-to-use tool designed to make all your Sketcher creation and edition tasks as simple as possible. SmartPick dynamically detects the following geometrical constraints:
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• • • • • • • •

support lines and circles alignment parallelism perpendicularity tangency concentricity horizontality and verticality midpoint

What are Constraints?
There are times when simple sketches are adequate for your design process, but you will often need to work on more complex sketches requiring a rich set of geometrical or dimensional constraints. The Sketcher workbench provides constraint commands which will allow you to fully sketch your profiles. When you apply constraint on curves, lines, circles and ellipses, the complete geometrical support is taken into account. As an example for this arc, the entire circle is taken into account when you apply constraints.

The location you click when selecting the element(s) to constrain is taken into account to create the constraints (it is used to position the constraints accurately). Therefore, when selecting the element(s) to constrain, it is important that you click where you want the constraint to be positioned. The software will then position the constraint according to the area where you clicked. This is especially true when creating constraints on certain types of curves (complex curves like splines, for example). In some cases, if you don't click in the right place when selecting the curve to constrain, the constraint and the geometry will be inconsistent.

Geometrical Constraints
A geometrical constraint is a relationship that forces a limitation between one or more geometric elements. For example, a geometrical constraint might require that two lines be parallel. If you select three lines, or two lines and a point, these elements will automatically result parallel to each others, as illustrated in the table further down.
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You can set a constraint on one element or between two or more elements.

Number of Elements

Corresponding Geometrical Constraints Fix Horizontal Vertical

One Element

Two Elements

Coincidence Concentricity Tangency Parallelism Midpoint Perpendicularity

Symmetry Equidistant Point When creating your constraint, remember that a green constraint is a valid constraint by default. Conversely, a yellow constraint indicates that the definition is not valid. The software lets you customize the colors and more generally the style of the constraints you use. To have details about these capabilities, see Infrastructure User's guide. Three Elements When you position the cursor on constraint symbols, the software calls your attention on the elements involved in the constraint system. Here are two examples of what you may get.

Dimensional Constraints
A dimensional constraint is a constraint whose value determines geometric object measurement. For example, it might control the length of a line, or the distance between two points. to finalize your profile. The Constraint You will use the Constraint command command allows you to set dimensional or geometrical constraints but you will mainly use it to set dimensional constraints. You can combine dimensional constraints to constrain a feature or sketch. You can set a dimensional constraint on one element or between two elements. Number of Elements One Element Corresponding Dimensional Constraints Length Radius/Diameter
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Two Elements

Distance Angle

You can apply a diameter constraint between two lines provided one of these lines is an axis line.

What About Constraining While Sketching?
Provided you previously activated the Constraint command , sketching certain elements automatically generates constraints although you did not specify that you wanted these elements to be actually constrained.

What About Constraint Visualization?
The table below lists the symbols used to identify the different constraint types: Symbol Constraint Type Perpendicular Coincidence Vertical Horizontal Fix/Unfix Parallel / Radius/Diameter

Hiding or Showing Constraints
Three existing settings are now available from the Visualization toolbar. They all let you adjust the visualization of constraints according to your needs. You can hide: • • • icon constraint diagnoses just by deselecting the Diagnosis dimensional constraints just by deselecting the Dimensional Constraints icon. geometrical constraints just by deselecting the Geometrical Constraints icon To know more about these capabilities, refer to the Filter paragraph in Symbols.

93

sketcher

What About Constraint Colors?
As soon as you detect a constraint problem, try to solve this problem. Otherwise, if you let the model be overloaded with diagnostics, it will soon become very hard for you to find the origin for each of these diagnostics. For more information about overdefined or inconsistent sketches, see Analyzing and Resolving overdefined or inconsistent Sketches COLOR and DIAGNOSTIC SOLUTION:

White: Under-Constrained Element The geometry has been constrained: all the relevant dimensions are satisfied but there are still some degrees of freedom remaining. Add constraints.

Brown: Element Not Changed • • • Some geometrical elements are over-defined or not-consistent, or the geometry is fixed, or there is either two free or one free and one fixed geometry in the same set.

Remove one or more dimensional constraints, or, in the case of fixed geometry, unfix it.

As a result, geometry that depend(s) on the problematic area will not be recalculated.
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Green: Fixed Element The geometry has been fixed using the Constraint Definition dialog box or the contextual menu (right mouse button).

Green: Iso-Constrained Element All the relevant dimensions are satisfied. The geometry is fixed and cannot be moved from its geometrical support. Geometry before and after being moved:
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Purple: Over-Constrained Element The dimensioning scheme is overconstrained: too many dimensions were applied to the geometry. Remove one or more dimensional constraints.

Red: Inconsistent Element At least one dimension value needs to be changed. This is also the case when elements are underconstrained and the system proposes defaults that do not lead to a solution. Add dimensions. Set dimension value(s) properly.

Inconsistent and Over-Constrained Elements If a sketch contains inconsistent and over-constrained elements when leaving the Sketcher workbench: • • For sketches created with versions starting from V5 R6: an error message will be displayed. For sketches created with versions up to Version 5 Release 5 (included): only a warning will be generated .
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Creating a Constraint Between a 2D and a 3D Element
When you need to create a constraint between a 3D element and a line, for example, this creation may result impossible. This is the case when the projection or intersection resulting use-edge does not give a unique solution. In other words, the use-edge (projection of one side of a pad) corresponds to several limit edges of the side. As a result, you will not be able to select this 3D element when creating the constraint. You will therefore have to use manually the projection operators.

Quickly Creating Dimensional/Geometrical Constraints
This task shows you how to set dimensional or geometrical constraints between one, two or three elements. The constraints are in priority dimensional. Use the contextual menu to get other types of constraints and to position this constraint as desired. In this particular case, we will set constraints between two elements by selecting the command and then a line and a circle. But what you can also do is set dimensional constraints by multi-selecting the circle and line, and then clicking the Constraint icon .

At any time, you may move the cursor: the distance value will vary accordingly. Click for positioning the newly created dimensional constraint. Enter the Sketcher workbench and create a circle and a line.

1. Click the Constraint icon: 2. Select the circle. The circle diameter constraint is displayed.
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3. Select the line. The relation between the two elements is reconsidered. In other words, the circle diameter constraint is no longer displayed.

4. Right-click to display the contextual menu and select the Tangency command to set a tangency constraint between the line and the circle. A tangency constraint has been created between the circle and the line.
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5. Click the Constraint icon: 6. Right-click the line and select the Line.x object -> Fix command from the contextual menu to prevent the line from moving. The line is fixed and the anchor, that is the fix symbol, is displayed.

To unfix the line, you can use the Line.x object -> Unfix command from the contextual menu. • A Projection/Intersection edge created by a constraint is hidden till the software detects a problem with this constraint. In this case, it appears to indicate the error. When creating a coincidence constraint between a point in the current sketch and a 3D element outside the sketch, by default the constraint is created on the projection of this 3D element whenever possible. (The constraint is created on the intersection of this 3D element with the sketch plane only when there is no projection for the 3D element.) So if you want to create a constraint on the intersection of the 3D element with the sketch plane, you need create an intersection between this 3D element and the sketch plane, and then create the coincidence constraint

•
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•

with the intersected point. We recommend not to create constraints or projections from wireframe elements which lie on a plane orthogonal to the sketch. As a matter of fact, the orientation of the result of these projections in the sketch plane is not stable. (Constraints with external elements use projection first). The Shift key lets you deactivate a constraint (auto-detected via SmartPick). The Ctrl key lets you lock the constraint currently created and lets you create others. Selecting one element lets you create a dimensional constraint. Selecting two elements lets you create a distance or an angle constraint. If you want to create a symmetry or equidistance constraints on three elements, you must select Allow symmetry line in the contextual menu after having selected the two first elements.

•

•

•

You can also define constraints using the Constraint Definition dialog command, or by means of the contextual command box, the (right-click).

Defining Constraint Measure Direction
This task shows you how to define the measure direction as you create a dimensional constraint. For example, you will assign the horizontal measure direction to a constraint to be created between two circles. Enter the Sketcher workbench and create two circles. See Creating Circles. 1. Create a distance constraint between the circles via the Constraint icon:
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2. Right-click the constraint and display and the select the Horizontal Measure Direction command from the contextual menu. The constraint is now positioned according to the horizontal direction.

3. Click anywhere to create the constraint. Via the contextual menu, you can also create a radius/diameter constraint on half a profile that will then be used as a revolution profile. The constraint diameter will correspond to the shaft diameter.

Creating Contact Constraints
This task shows you how to apply a constraint with a relative positioning that can be compared to contact. You can either select the geometry or the command first. This constraint can be created between either two elements. These constraints are in priority: • • • concentricity coincidence tangency

Use the contextual menu if you want to create other types of constraints. Open the Constraint_Contact.CATPart document. 1. Select the Contact Constraint icon from the Constraint toolbar (Constraint Creation subtoolbar).
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The Concentricity constraint symbol appears and the constraint is created.

According to the elements you select, a single type of constraint is proposed for defining the contact: • • • • • • • • A point and a line: coincidence Two circles: concentricity Two lines: coincidence Two points: coincidence A line and a circle: tangency A point and any other element: coincidence Two curves (except circles and/or ellipses) or two lines: tangency Two curves and/or ellipses: concentricity

You can modify or even delete the contact constraint. For this: 1. Make sure either the Constraint active in the Constraint toolbar. or the Contact Constraint icon is

2. Right-click the constraint you want to modify or delete.
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3. Select the option corresponding to the desired operation, from the contextual menu. For example, select the Distance constraint type to turn the contact constraint into a distance constraint.

The Distance constraint symbol and value now appear as shown here.

Creating Constraints via a Dialog Box
This task shows you how to set various geometrical constraints using a dialog box. For example, you can use the Constraint command to finalize your profile and set constraints consecutively. You may define several constraints simultaneously using the Constraint Definition dialog box, or by means of the contextual command (right-click). If you want the constraints to be created permanently, make sure you activate the Dimensional constraints icon and/or the Geometrical constraints

(depending on the type of constraint you want to create) from the icon Sketch Tools toolbar. If you do not activate these icons, the constraints will only be created temporarily. Open the Constraint_DialBox.CATPart document. 1. Multi-select the elements to be constrained. For example, two lines.
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The Constraint Definition dialog box appears, indicating the types of constraints you can set between the selected lines (selectable options).

•

• •

These constraints may be constraints to be applied either one per element (Length, Fix, Horizontal, Vertical) or constraints between two selected elements (Distance, Angle, Coincidence, Parallelism or Perpendicular). Multi-selection is available. If constraints already exist, they are checked in the dialog box, by default.

Note that, by default, a diameter constraint is created on closed circles when checking the Radius/Diameter option. If you need a radius constraint, you just have to convert this constraint into a radius constraint by double-clicking it and choosing the Radius option.

3. Check the Perpendicular option to specify that you want the lines to always remain perpendicular to each others, whatever ulterior modifications. 4. Click OK. The perpendicularity symbol appears.
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5. Now, select the bottom line and click the Constraints Defined in Dialog Box icon.

The Constraint Definition dialog box indicates you can set the line as a reference. 6. Check the Fix option in the dialog box and click OK. The anchor symbol appears indicating that the line is defined as a reference.

7. Select the corner on the left of the profile and click the Constraints Defined in Dialog Box icon .

The Constraint Definition dialog box indicates you can choose the Radius/Diameter or Fix option. 8. Check the Radius/Diameter option in the Constraint Definition dialog box and click OK.

The radius value appears.
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9. Multi-select both vertical lines and click the Constraints Defined in Dialog Box icon. 10. Check the Distance option in the Constraint Definition dialog box and click OK. The distance between both lines appears.

At any time after the constraint was created, you can modify the constraint measure direction and/or reference. See Defining Constraint Measure Direction for more details.

Editing/Modifying Constraints
Modifying Constraints
In this task, you will find the following information: • • • • Step-by-step Scenario showing you how to edit constraints defined in the Sketcher. Modifying Constraint Values by Using the Shift Key About Diameter and Radius Constraints Deactivating or Activating Constraints

Open the Constraint_Definition.CATPart document. 1. Double-click Sketch1 as the sketch to be edited. You are now in the Sketcher workbench.
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2. Double-click the Radius.6 constraint. The Constraint Definition dialog box appears. 3. Select the Reference option to make the constraint a reference. The Radius field is deactivated, indicating that the value is now driven by modifications to the sketch.

The radius value is displayed in brackets in the geometry area.

If you drag the corner center point, you can check that the radius value is updated.
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4. Double-click the Angle.9 constraint. The Constraint Definition dialog box appears. 5. Type 125deg and click OK. The new value is displayed in the geometry area. It affects the angle. The sketch shape is also modified due to the radius previously converted into a measure.

6. Double-click the Offset.14 constraint. The Constraint Definition dialog box appears. 7. Click the More button to access additional information.

8. Click the Line.5 component.
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The related geometry is highlighted. 9. Click Reconnect... to redefine the constraint component. 10. Select Line.6 and type 52mm in the Value field. 11. Click OK. The position of the profile is modified accordingly.

12. Exit the Sketcher. The application has integrated the modifications to the sketch.
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13. Double-click the Offset.3 constraint. The Constraint Definition dialog box appears. 14. Type 30mm in the Value field and click OK. The offset is modified accordingly.

In the 3D area, if you select the blue pad, the Edit Parameters contextual command allows you to display all parameters and constraints defined for that pad. When you are in the Repeat mode (you double-clicked on the command for creating a constraint), if you try to edit an existing constraint while creating another constraint, the modification will only be taken into account when you have finished creating this other constraint.

Modifying Constraint Values by Using the Shift Key
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It is now possible to edit dimensional constraint values just by dragging constrained geometry. This is a quick way of editing constraints without launching dialog boxes. 1. Press the Shift key and drag the vertical line to the right as shown below.

You can notice that the value of the angle constraint is not only modified as you are dragging the cursor, but it is also displayed between parentheses, meaning that it is temporarily converted into a reference. In other words, you can move the geometry freely, with respect to geometrical constraints. 2. Press the Shift key and drag the vertical line to the right as shown below. The modified angle value is displayed (137.913), and is no longer a reference:
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If the Snap to Point option is active, the geometry is moved according to the spacing you defined for the grid. For more information, refer to the customization for Sketcher).

About Diameter and Radius Constraints
You can obtain a radius constraint by editing a diameter constraint. You just need to double-click the diameter constraint and choose the radius option in the dialog box that appears. If you need to create a formula remember that: • • the parameter corresponding to the radius or diameter constraint is referred to as RadiusX.object this parameter always contains the radius value.

For more information about formulas, refer to Knowledge Advisor User's Guide.

Deactivating or Activating Constraints
You can deactivate a constraint by right-clicking it and selecting the XXX.N.object -> Deactivate option from the contextual menu. In other words, this constraint will still appear on the sketch but will not behave as such. Deactivated constraints appear preceded by an open-close brackets symbol in the geometry or mask in the specification tree. Conversely, to activate a constraint, use the Activate option from the contextual menu.
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Modifying Constraints On/Between Elements
This task shows you how to edit geometrical constraints defined in the Sketcher or in the 3D area. Open the Constraint_Definition.CATPart document and double-click Sketch1 in the specification tree.

1. Select the right vertical line and click the Constraint command from the Constraint toolbar.

The Constraint Definition dialog box appears. 2. Check Length and Verticality.

3. Click OK to apply the modification. The line is vertical.

4. Select the left vertical line and click the Constraint command

.

The Constraint Definition dialog box appears, indicating that a verticality constraint is already defined for the line.
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6. Click OK to apply the modification. The symbol for verticality is removed. The profile now looks like this:

Edit Multi-Constraint
This task shows you how to quickly edit all or some dimensional constraints contained in a sketch. When you are editing a dimensional constraint value, the whole sketch is reevaluated. Using the new Edit Multi-Constraint capability, the sketch behavior differs: the constraints values you modify are evaluated at the same time once you have click on OK in the dialog box. Open the Constraint_DialBox.CATPart document, select the whole geometry using the trap tool and apply the Auto-Constraint command. 1. Click the Edit Multi-Constraint icon from the Constraint toolbar.

2. The Edit Multi-Constraint dialog box that appears displays the whole dimensional constraints of the sketch.
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3. In case you wish to restrict the selection, that is access not all of the constraints but just a few of them, first select the constraints of interest, then click the Edit Multi-Constraint icon . Once the dialog box is displayed, you still can add other constraints if needed. 2. Enter a new value, for instance 70 to edit Offset.21, the selected constraint. Note that standard contextual items, those you can get from any constraint definition dialog box, are available from the value field. Among these commands are Change Step that let you adjust the way of entering values.

3. Select Radius.15 then enter 18 as its new value. Note that in the geometry area, Offset.21 is now displayed in light blue, indicating that its value is being edited. The new value is also displayed. Note that the dialog box displays initial values and current values. 4. Click Preview to get an idea of the result:
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5. Assuming that you are not satisfied with the new value for Radius.15, just click the Restore Initial Value button. If you wish to restore several initial values, just use Ctrl while selecting the desired constraints, then click the Restore Initial Value button.

Diameter Dimensions

The Edit Multi-Constraint dialog box indicates diameter dimensions as radius dimensions with their corresponding values.

Fixing Elements Together
In this task, you are going to attach sketcher elements together by using the Fix Together command. This capability lets you constrain a set of geometric elements even if constraints or dimensions are already defined for some of them. Once constrained, the set is considered as rigid and can be easily moved just by dragging one of its elements. One of the interest of this capability is that it also allows you to make 2D kinematics studies in the Sketcher. This task shows you how to make two elongated holes perpendicular, then how to position them inside a rectangle, while using the Fix Together command. • • • • • • • • Making Elongated Holes Perpendicular (scenario) Selecting Geometrical Elements Degrees of Freedom Positioning Holes in the Rectangle (scenario) Editing a Fix Together Constraint Additional Constraints Removing Geometrical Elements Applying Operations onto a Fix Together Constraint

116

User Tasks

•

Methodology

Enter the Sketcher workbench and create a rectangle and two nonconstrained elongated holes next to it.

Making Elongated Holes Perpendicular
Prior to using the Fix Together command, consider the following scenario: to make both elongated holes perpendicular to each other, you could be tempted to select one oblong hole then drag it next to the second one, and eventually set a perpendicular constraint. The fact is that setting the constraint if no other constraints are set, deforms the holes. To quickly achieve the desired geometry, follow the steps as explained below. 1. Select one elongated hole by using the selection trap. 2. Click the Fix Together icon: The Fix Together Definition dialog box that appears displays all selected geometrical elements.

Selecting Geometrical Elements
Dependencies
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To assume that the rigid body behavior can be managed, by default the application includes element dependencies. This is indicated by the activated Add/Remove Dependencies button. When adding a spline for instance, all its control points and control point tangencies are automatically added even if they were not selected. Note that you can deactivate this behavior for advanced uses cases by deselecting the Add/Remove Dependencies option. The following table lists geometric elements and their corresponding dependencies: Geometric Element Line Circle/Ellipse Arc of circle/Ellipse Parabola/Hyperbola Conic by two points Conic by four points Conic by five points Connect Curve Spline Dependency Start point + End point Center point enter point + Start point + End point Start point + End point Start point + End point + (Start Tangent curve + End Tangent curve or Tangent Intersection point) + (Passing point or Not) Four points + One Tangent curve Five points First point + Second point + First curve + Second curve Control points + Tangent directions

Number of Elements
You can select as many geometrical elements as you wish, but just remember that a geometrical element can be used by only one Fix Together constraint.

Absolute Axis
You can select the origin, the H or V Direction of the sketch absolute axis. These three elements cannot be selected at the same time by a selection trap. You need to explicitly select them one by one. 3. Click OK to confirm. The Fix together constraint is created as indicated by a green paper clip symbol.
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Degrees of Freedom
The set of geometric elements constrained by Fix Together has three degrees of freedom whatever the number of elements. In order to be fully defined, the set needs to be dimensioned to fix geometry taking up at least the three degrees of freedom (one rotation and two translations). A geometric element within a Fix Together constraint can be fixed (Fix the dialog box added). If, for instance, a constraint available from Fix Together constraint contains a fixed line, the set of geometric elements has one single degree of freedom which is along the direction of the line. 4. Repeat the operation for the second elongated hole. Just to check that you can now manipulate each hole by keeping its rigid body. 5. Select them and drag them to any location.

6. Set the perpendicular constraint.
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Positioning Holes in the Rectangle
7. To position both holes inside the rectangle, delete the constraints you previously set. 8. Create only one Fix Together for both holes.

9. Drag the holes all together inside the rectangle after selecting any of their geometrical element and add constraints between the rectangle and the holes to specify their exact positions.

10. Select the Fix Together constraint attaching the holes and use the FixTogether.x object-> Deactivate contextual menu item. Note that if the Fix Together constraint is deactivated, the geometric elements are always seen by the application as belonging to a rigid set. So selecting them remains impossible for defining another Fix Together constraint.
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You can now modify the shapes of the holes as the constraint is deactivated. 11. Enlarge the right hole.

12. Note that passing the cursor over an activated or not Fix Together constraint highlights the associated geometry.

Editing a Fix Together Constraint
You can add a geometrical element to a Fix Together constraint provided it belongs to the current sketch and is not already included in another Fix Together constraint. The selection or the pre-selection of the elements to add depends on this verification during the Fix Together constraint creation and editing. You can add several elements at the same time either by using the CTRL key or the selection trap. After a selection: • • Geometrical elements not used for the definition are added Geometrical elements that are already part of the definition are removed.

Additional Constraints
• Adding constraints between elements involved in a Fix Together constraint and other elements involved too in a distinct Fix Together constraint or free elements allows you to position the
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•

•

fixed together set. Adding a constraint to a fixed together element brings about an over-constrained system. But unlike other types of constraints, when exiting the Sketcher, the application does not detect no inconsistency. All existing or added constraints on geometric elements of a Fix Together constraints are seen as over-defined (in purple when solving status is displayed).

Except for Fix constraints, no constraints are solved between geometric elements linked by the same Fix Together constraint. However, no update error appears on such over-defined constraints (between Fixed Together geometric elements) and the part is successfully updated.

Removing Geometrical Elements
There are two ways of removing geometrical elements from a Fix Together constraint: • • by deleting the geometrical elements: dependencies are deleted too. by editing the Fix Together constraint: o select the Add/Remove dependencies option and select the geometry to be removed: dependencies are deleted too. o unselect the Add/Remove dependencies option and select the geometry to be removed: dependencies are not deleted.

When the number of geometric elements in the set is less than two, the Fix Together constraint is NOT automatically deleted.

Applying Operations Onto Fix Together Constraint
Copy/Paste
You can copy and paste a fix together set (not the constraint alone). To do so: 1. Select the paper clip. 2. Use the Fix Together object -> Select Geometrical Elements contextual menu item. 3. Use Ctrl to include the paper clip in the selection. or 1. Use the selection trap to ensure that the paper clip and the associated constrained geometry are selected.
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2. Apply the Copy -> Paste capability.

Mirror
By switching off the Geometric constraints mode, the Fix Together constraint is taken into account like the other constraints when mirroring geometries and keeping the initial constraints:

...otherwise, the application creates symmetry constraints as requested.

Break/Trim/Corner/Chamfer
You can apply the Break , Trim , Corner and Chamfer

commands onto elements attached by a fix together constraint. When all the geometrical elements belong to the same Fix Together constraint, the constraint is updated accordingly. For instance, when breaking a curve, the new half curve is automatically added to the definition.

Methodology
Depending on your geometry and your needs, you will use the Fix Together command or the the Auto Constraint command, bearing in mind that: • The Fix Together command creates only one constraint for a group
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or elements. • The Auto Constraint command detects all possible constraints between the selected elements then creates these constraints. This means that sometimes you may create a lot a unnecessary constraints just for imposing a rigid behavior. For more information, refer to Autoconstraining a Group of Elements.

command is a way of getting better solving The Fix Together performances as well as solving more complex systems including rigid subparts.

Auto-Constraining a Group of Elements
The Auto Constraint command detects possible constraints between the selected elements and imposes these constraints once detected. This task shows you how to apply this command on a profile crossed by a vertical line. Open the Constraint_Contact.CATPart document. 1. Select the profile to be constrained.

2. Click the Auto Constraint icon: The Auto Constraint dialog box is displayed. The Elements to be constrained field indicates all the elements detected by the application after selecting the profile. 3. Click the Symmetry lines field and select the vertical line in the
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geometry area. All the elements in the profile that are symmetrical to the Line will be detected.

The Reference elements option allows you to select references to be used to detect possible constraints between these references and the elements selected. Once the profile is fully constrained, the application displays it in green. To know how to use the Constraint mode, refer to Stacked and Chained Modes. 4. Click OK to constrain the sketch including the profile and the vertical line and, if needed, modify the location of the constraints. The constraints created are: • • • • • • Two angles: 111.344 and 137.023 One radius: 10.721mm Two offset: 53.35mm and 53.35mm Horizontality Tangency Symmetry

The sketch is not displayed in green because it is not constrained in relation to external elements (edges, planes and so on).
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Stacked and Chained Modes
When using the Auto-constraint command, there are two ways of considering what a reference is. • You can decide that the element you explicitly select as the reference is not an absolute reference, which means that this element is used only once, just to compute the first constraint. Then, the system reuses the constrained element as a reference in turn, to compute the next constraint and so on. If you choose this computation mode, you then need to set the Chained constraint mode.

In the following example, V axis is used as the first reference and it is used just once. You can notice that the other two offsets (70 and 50) are computed in relation to the lines. The picture shows them in red:
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•

If you decide that the element you select as the reference is an absolute reference for all the constraints that will be detected, you need to specify this by setting the Stacked constraint mode.

In the following example, because V axis is set as the absolute reference, all offset constraints requiring a reference element are computed in relation to V. The picture shows them in red:

Animating Constraints
This task shows you how constrained sketched elements react when you decide to make one constraint vary. In other words, you will assign a set of values to the same angular constraint and examine how the whole system is affected. You will actually see the piston working.
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Open the Animating_Constraints.CATPart document. 1. Select the Angle.54 constraint.

2. Click the Animate Constraints icon: The Animate Constraint dialog box appears.

• •

The First value and Last value fields let you define the maximum and minimum values for the constraint. The Number of step field defines the number of values you wish to assign to the constraint between the first and last values.

3. Type 15 as Number of steps value.
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4. Type 115deg for the First value. 5. Type 246deg for the Last value. 6. Check the Hide constraints option for hiding constraints. This can be useful when there are many elements in the sketch.

7. Select the Loop button:

8. Click the Run Animation button to see how the sketch is affected by the different values assigned to the constraint. The command induces a clockwise rotation while moving the rectangle up and down. 8. Unselect the Hide constraints option to display the constraints again. Once the maximum value is reached, that is 360 degrees, the sketch looks like this:
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Actions
Run Back Animation: shows the different constraint values starting from the last value. In our scenario, we saw a counterclockwise rotation. Pause Animation: stops the animation on the current value. Stop Animation: stops the animation and assigns the first value to the constraint. Run Animation: starts the command using the option defined (see below).

Options
One Shot: shows the animation only once. Reverse: shows the animation from the first to the last value, then from the last to the first value. Loop: shows the animation from the first to the last value, then from the last to the first and so on. Repeat: repeats the animation many times from the beginning to the end.
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Analyzing and Resolving Over-Constrained or Inconsistent Sketches
In evaluating geometry, the system considers the degree of freedom that it has. In two dimensions, points and lines have two degrees of freedom, circles have three and ellipses have five degrees of freedom. Fixed geometry will never be moved by the system, and has no degree of freedom. If all of the degrees of freedom of a geometry have been taken up by a consistent combination of dimensions and fixed geometry, that geometry is said to be isoconstrained (also known as well-defined). Geometry that still has some degrees of freedom is said to be under-constrained (also known as under-defined). Status codes are given through a graphical way (colors) during the Sketch edition. The update error dialog box when returning in 3D explicitly gives them (check visualization of diagnosis in Tools -> Options -> Sketcher -> Colors). Note that: • The system will mark all entities that are relevant to a problem rather than just the first item encountered. So, for instance, in the case of an inconsistent triangle with sides 10, 10 and 50, all three dimensions would be marked as INCONSISTENT. The order in which the codes are listed below is significant. The system will test to see whether a geometry should have the status OVER-CONSTRAINED before considering whether it should be INCONSISTENT.

•

This chapter describes the over-constrained and inconsistent status codes calculated by the system and explain methods for solving any underlying problems with a Sketch. You will find the following information: • • • • • • Over-constrained Resolving Over-constrained Cases Inconsistent Resolving Inconsistent Cases Not Changed Parametric Curves

Over-constrained
In many sketches, the user will specify more than the minimum required number of dimensions or constraints. In certain cases the system will ignore redundant constraints and solve the Sketch. In other cases it will mark parts of the Sketch as over-constrained. The descriptions below refer to consistent constraints and dimensions. Dimensions are said to be consistent if their values are satisfied by the position of the geometries. Geometry will be marked as over-constrained when it cannot be solved because
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there are too many dimensions acting on it for the degrees of freedom available. A dimension will be marked as over-dimensioned if it conflicts with one or more other dimensions and it is not possible to vary the value of the dimension and still find a consistent solution. For example, the geometry and dimensions in the figure below will be over-constrained because the dimension values cannot be varied independently, even though they can all be satisfied by appropriate geometry positions.

However, the system is able to cope with certain over-constrained situations involving logical constraints. This is important because logical constraints such as parallelism are likely to be over-specified when a design is being built up interactively. For example, if two lines are defined to be parallel and then a distance is subsequently given between them the parallelism is then specified twice. The following is a list of some of the over-constrained configurations that can be solved: • • • Multiple constraints between the same geometries. For instance, two circles can have several tangent constraints between them. Multiple coincident constraints between geometries of the same type. For instance, three points can each be made coincident to the other two. Multiple coincident constraints between lines and points. For instance, two lines can be made coincident, and their endpoints can be made coincident with the other line.

Parallel and perpendicular constraints. Any combination of parallel and perpendicular constraints will be reduced to the minimum set required, and any excess ones will be ignored. Note that a distance dimension between two lines is treated as a parallel constraint, except that it will never be one of the constraints that is ignored. Symmetric constraints . There are many configurations where symmetric constraints will make other constraints redundant. These are recognized by the system. For example, if two lines are made symmetric two of the coincidence constraints between the points and the lines are redundant.
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Resolving Over-constrained Cases
Over-constrained entities occur in loops where all of the entities in a loop conflict with each other. Over-constrained entities can also occur when there are too many fixed geometries. To resolve over-constrained problems, the user will need to: • • • Set as references dimensions Deactivate or remove constraints Unfix geometry

Note that the system will evaluate as much of the geometry as possible. It determines exactly which dimensions are contributing to the situation.

Inconsistent
This section describes when the inconsistent status codes can occur and how a user can modify the Sketch to avoid them. In general, the inconsistent status shows that the user is attempting to make a change to the Sketch that is too large. In this context, "large" is relative to the size of the Sketch. Parts of a Sketch may become inconsistent as a result of a number of different operations. The most common of these are as follows: • • • • • The user changes the value of a dimension. This will normally occur for cases where there would be large changes to one or more geometries. The user adds a dimension or constraint to a Sketch, in order to move geometry. When dragging geometries, the user attempts to input a large transformation. When the geometric type of a use-edge is changed (geometry coming from the projection or intersection of a 3D geometry) When there are use-edge large positions or orientations changes.

The geometry has not been solved because: • • No solution exists for the current values of dimensions. The system cannot find a solution, even though a solution may exist with the current values of dimensions. This occurs when trying to make large changes to under-constrained sketches or to parametric curves (See section Overconstrained and Inconsistent on Parametric Curves below for further details). The system has not find a solution that respects the previous chirality.

•
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Chirality determines the way that geometry is positioned relative to the geometries to which it is dimensioned. A dimensioning scheme can often be satisfied by a number of different configurations. The system will always evaluate a new configuration that has the same chirality as the original geometry. It is important to realize that geometry in the system always has an original configuration, which is used for deciding the chirality.

Resolving Inconsistent Cases
If the inconsistent status code was a result of changing a dimension value, the problem will be resolved by changing the dimension back to its old value. However, in some cases the user may want to modify other parts of the Sketch to allow the change to be made. The following sections describe different ways that can be tried. When attempting to solve a problem, the user should focus on the geometries and dimensions in the Sketch with the inconsistent status code. In order to decide how to avoid the status code it is useful to check first if the problem comes from inconsistent dimensions. An example of this is a triangle with sides of length 50, 50 and 120.

(a) Inconsistent, will not be changed (b) Can be evaluated, will be changed. In this case, the problem may be solved through: • • • Changing a dimension value. Setting a dimension as a reference. Deactivating a dimension.

Other cases occur on sketches that are not fully dimensioned. The following techniques can be used to solve the problem by helping the system to converge and find a solution: • • • Moving geometry. Changing dimension values. Adding additional constraints to reduce the degrees of freedom.
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Not Changed
The not changed status is used in the following cases: • When geometry becomes over-constrained or inconsistent, the system will not be able to position any other geometries that depend on it. These dependent geometries and their associated dimensions (and any others that depend on them) will be marked not changed. Dimensions between two fixed geometry will be given the status code not changed. Dimension between two free or one free and one fixed geometry in the same set will be given the status code not changed.

• •

Parametric Curves
This section is an overview of specific over-constrained and inconsistent problems on parametric curves. The Sketcher can manipulate points, lines, circles and ellipses but can also manage splines and nurbs. These parametric curves can be created: • Through an Intersection or Projection of a 3D geometry in the Sketch. After isolating it, constraint can be used to change the position of the curve. The system is unable to directly modify the shape because the curve, which have no internal freedoms that the system can control, have only three degrees of freedom. By the Spline command. The curve is defined from other geometries. The parametric curve is said dependent. It is constructed so it passes through a series of control points.

•

Constraints and dimensions can be added between a dependent parametric curve and other geometries in the sketch. Solving problems will occur: • • If the position of the defining geometry depends upon the position of the parametric curve, either directly or indirectly. When the other geometry of the constraint or dimension is an other parametric curve or dependent parametric curve.

Always use the Constraint command without dialog box to specify where the constraint must be created on the curve . Through the Constraint Defines in Dialog Box command, the selection points are not taken into account. On fully under-constrained sketches, the system can have difficulty choosing between changing the shape and/or moving its defining geometry especially when it supposes to make large changes. Moving the geometry will help the system find a
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consistent solution in that case.

Performing Operations on Profiles
Performing Operations on Profiles
Before you begin, make sure you are familiar with Tools For Sketching. The Sketcher workbench provides a set of functionalities for performing operations on profiles. Note that you can either click on a profile or use the Sketch tools toolbar. Creating Corners: Creates a rounded corner (arc tangent to two curves) between two lines using trimming operation. Creating Chamfers: Creates a chamfer between two lines using trimming operation. Trimming Elements: Trims two lines (either one element or all the elements) Trimming Multiple Elements: Trims a few elements using a curve type element. Breaking and Trimming: Quickly deletes elements intersected by other Sketcher elements using breaking and trimming operation. Closing Elements: Closes circles, ellipses or splines using relimiting operation. Complementing an Arc (circle or ellipse): Creates a complementary arc. Breaking Elements: Breaks a line using a point on the line and then a point that does not belong to the line. Creating Mirrored Elements: Duplicates existing Sketcher elements using a line, a construction line or an axis. Moving Elements by Symmetry: Moves existing Sketcher elements using a line, a construction line or an axis. Translating Elements: Performs a translation on 2D elements by defining the duplicate mode and then selecting the element to be duplicated. Multiselection is not available. Rotating Elements: Rotates elements by defining the duplicate mode and then selecting the element to be duplicated. Scaling Elements: Scales an entire profile. In other words, you are going to resize a profile to the dimension you specify. Offseting Elements: Duplicates a line, arc or circle type element. Projecting 3D Elements onto the Sketch Plane : Projects edges (elements you select in the Part Design workbench) onto the sketch plane.
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Creating Silhouette Edges: Creates silhouette edges to be used in sketches as geometry or reference elements. Intersecting 3D Elements with the Sketch Plane: Intersects a face and the sketch plane. Copying/pasting Elements: Explains how sketched elements behave when copying/pasting elements that were created via projection or intersection. Isolating Projected/Intersected Elements: Isolates the elements resulting from the use of the Project 3D Elements or Intersect 3D Elements icons.

Performing a Quick Geometry Diagnosis: Displays a quick diagnosis of a sketch geometry. Analyzing the Sketch: Displays a global or individual status on the sketch and correct any problem. Creating Output Features: Creates an output of a selected sketch which can be published and updated independently in the 3D area. Creating Profile Features: Creates a feature made of a set of curves, connected or not and made independent from the other elements defined in the same sketch.

Creating Corners
This task shows how to create a corner (arc tangent to two curves) between two lines using the different trimming options. This page deals with the following information: • • • • • • • Trimming Both Lines Trimming the First Line No Trimming Trimming Both Lines Until their Intersection Trimming Both Lines and Creating Construction Lines Until their Intersection Trimming Both Lines and Creating Construction Lines Optimizing the Operation By Multi-Selection

Open the Move_Corner.CATPart document.

1. Click the Corner icon: The possible corner options are displayed in the Sketch tools toolbar. The Trim All Elements option is selected by default.
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Trimming Both Lines
2. Select the Trim All Elements option: 3. Select the two lines.

The two lines are joined by the rounded corner which moves as you move the cursor. This lets you vary the dimensions of the corner. 4. Enter the corner radius value in the Sketch tools toolbar: 22mm You can also click when you are satisfied with the corner dimensions. Both lines are trimmed at the points of tangency with the corner.

Trimming the First Line
2. Select the Trim First Element option: 3. Select the two lines. The first line is trimmed.
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No Trimming
2. Select the No trim option: 3. Select the two lines. The corner is created. No line is trimmed.

Trimming Both Lines Until their Intersection
2. Select the Standard Lines Trim option: 3. Select the two lines. The corner is created. The trimmed lines are set as standard lines.

139

sketcher

Trimming Both Lines and Creating Construction Lines Until their Intersection
2. Select the Construction Lines Trim option: 3. Select the two lines. The corner is created. The trimmed lines are set as construction lines.

Trimming Both Lines and Creating Construction Lines
Enter the Sketcher workbench and create two intersecting lines.

2. Select the Construction Lines No Trim option: 3. Select the two lines. The corner is created. The trimmed lines are set as non-trimmed construction lines.

•

By default, centers are created but if you do not need them you can specify this in the Options dialog box. for this, go to Tools > Options-> Mechanical Design -> Sketcher option (Sketcher
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•

tab).). You can create corners between curves.

Optimizing the Operation By Multi-Selection
You can create several corners just by multi-selecting for example, the rectangle endpoints and enter a radius value in the Radius field (Sketch tools toolbar). Four corners are created at the same time with the same radius value.

Clicking on the Formula icon displays the parameter driving the radius value of the corners you have just created.

Creating Chamfers
This task shows how to create a chamfer between two lines trimming either all, the first or none of the elements, and more precisely using one of the following chamfer definitions: • • • Angle/Length (Hypotenuse) Length1/Angle Length1/Length2
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This page deals with the following information to create chamfer: • • • • • • • Trimming Both Lines Trimming the First Line No Trimming Trimming Both Lines until Their Intersection Trimming Both Lines and Creating Construction Lines Until their Intersection Trimming Both Lines and Creating Construction Lines Dimensioning the Edge Intersection Point

You can create chamfers between any type of curves (lines, splines, arcs and so forth). Even if the curves are not consecutive, the chamfer will be created. Open the Chamfer.CATPart document.

1. Click the Chamfer icon: The possible chamfer options are displayed in the Sketch tools toolbar. The Trim All Elements option is selected by default. Six profile mode options are available: • • • • • • Trim All Elements: Trim The First Element: No Trim: Standard Lines Trim: Construction Lines Trim: Construction Lines No Trim:

Three dimension mode options are available: • Angle and Hypotenuse:
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• •

First and Second Length: Angle and First Length:

Trimming Both Lines
2. Select the Trim All Elements option: 3. Select the first line and the second line. The selected lines are highlighted.

The second line is also highlighted, and the two elements are connected by a line representing the chamfer which moves as you move the cursor. This lets you vary the dimensions of the chamfer whose values appear in the Sketch tools toolbar. 4. Click to indicate where to create the chamfer. The chamfer with both elements trimmed is created.

Provided the Dimensional Constraint option command is active, the constraints will be created between what we call in the scenarios below the old intersection point and new end points of the lines.
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Trimming the First Line
2. Select the Trim The First Element option: 3. Select the first line and the second line. The chamfer with one element trimmed is created.

No Trimming
2. Select the No Trim option: 3. Select the first line and the second line. The chamfer with no element trimmed is created and the original lines are kept.

Trimming Both Lines Until their Intersection
2. Select the Standard Lines Trim option:
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3. Select the first line and the second line. The chamfer is created and the two lines are trimmed up to the two lines intersection.

Trimming Both Lines and Creating Construction Lines Until their Intersection
2. Select the Construction Lines Trim option: 3. Select the first line and the second line. • • The chamfer is created and the two lines are trimmed. Two new lines are created between the intersection and the trimmed extremity of the lines, and set as construction lines.

Trimming Both Lines and Creating Construction Lines
2. Select the Construction Lines No Trim option: 3. Select the first line and the second line. • • The chamfer is created and the two lines are trimmed. Two new lines are created between the previous extremities and the
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trimmed extremity of the lines, and set as construction lines.

Dimensioning the Edge Intersection Point
You can create several chamfers just by multi-selecting for example, the rectangle endpoints and entering the definition parameters in order to define these chamfers (Sketch tools toolbar). Four chamfers are created at the same time with the same parameter values.

Using the Length1/Length2 Option

Between Perpendicular Lines

Between Non-Perpendicular Lines
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Between Crossing Lines

Between Non-Intersecting Lines

Note: if the lines are parallels, the extremity points are used to compute the lengths because the virtual intersecting point does not exist.
Between Intersecting Curves
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Between Non-Intersecting Curves

Using the Length1/Angle Option

Between Non-Perpendicular Lines
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Between Non-Intersecting Curves

Closing Elements
This task shows how to close circles, ellipses or splines using relimiting operation. Create a three point arc .

1. Click the Close icon from the Operation toolbar (Relimitations subtoolbar).
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The arc is now closed.

In the case of a spline that was relimited by using the Trim icon is set to its original limitation.

, the spline

Spline after it was relimited

Spline after you clicked the Close icon
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Complementing an Arc (Circle or Ellipse)
This task shows how to complement an arc (circle or an ellipse).

Create a three points arc.

1. Click on the arc to be complemented to select it. For example, the three points arc.

2. To complement the arc you can either • Click the Complement icon from the Operation toolbar (Relimitations subtoolbar).

• •

or right-click on the selected item and select Complement in the contextual menu -> Circle.1 object. or go to Insert -> Operation -> Relimitations and select Complement.
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3. The complementary arc appears.

Breaking and Trimming
Trimming Elements
This task shows how to trim geometrical elements: • • Trimming Two Elements Trimming One Element

Trimming Two Elements
Enter the Sketcher workbench and create two intersecting lines.
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1. Click the Trim icon: The Trim toolbar options are displayed in the Sketch tools toolbar.

The Trim All Elements option is the default option: 2. Select the first line.
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3. Position the cursor on the element to be trimmed. The second element is highlighted too, and both lines are trimmed.

4. Position the cursor on the same first element. The first element will be trimmed at the location of the second position.

The location of the relimitation depends on the location of the cursor. 5. Click when you are satisfied with the relimitation of the two lines.
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• •

•

In multi-selection mode, no extrapolation is done by trimming command. If you trim an element created from a projection or an intersection, then this element's extremities are not constrained anymore to follow the extremities from the element they are issued from. If the extremity point of the trimmed line is constrained, or if the extremity point of the trimmed line is a geometrical element (not a construction element), then a coincidence constraint will be created between this point and the trimmed line.

Trimming One Element
This task shows how to trim just one element. Enter the Sketcher workbench and create two intersecting lines.

1. Click the Trim icon: 2. Click the Trim First Element option: 3. Select the first line.
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4. Position the cursor to the second line. The first line selected is trimmed.

5. Position the cursor on the same first element. The first element will be trimmed at the location of the second position.
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The location of the relimitation depends on the location of the cursor. 6. Click when you are satisfied with the relimitation of the first line.

Breaking and Trimming
This task shows how to quickly delete elements intersected by other Sketcher elements using breaking and trimming operations.
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Open the Sketcher_01.CATPart document: • Ensure that the Geometrical Constraints option is activated:

1. Click the Quick Trim icon: The Quick Trim toolbar options are displayed in the Sketch tools toolbar.

2. Select the Beak and Rubber In option: 3. Select the arc you wish to be deleted from the Circle.2

The arc of circle has been relimited as shown here. Coincidence constraints have been created.
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4. Click the Quick Trim icon: 5. Select the Beak and Rubber Out option: 6. Select the arc you wish not to be deleted from the Circle.3

The arc of circle has been relimited as shown here. Coincidence constraints have been created.
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7. Click the Quick Trim icon: 8. Select the Break and Keep option: 9. Select Line.3 as the element you wish to be broken.

Line.3 has been broken in three segments delimited by the other lines. Coincidence constraints have been created.
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• •

If you need to delete several elements, you can double-click the icon and delete the elements one after the other. You cannot use the Quick Trim and/or the Break commands for composite curves (which are projected/intersected elements composed of several curves). However, you can work around this functional restriction by using the Trim command (this enables you to get the same results for composite curves than by performing the Quick Trim and the Break operations).

Breaking Elements
This task shows how to break a line using a point on the line and then a point that does not belong to the line. The Break command lets you break any type of curve, except composite curves (see note below). You can use any Sketcher element to break curves. • Enter the Sketcher workbench and create two lines and a point.
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•

Ensure that the Geometrical Constraints option is activated:

1. Click the Break icon: 2. Select the line to be broken.

3. Indicate where to create the break.
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The line is broken at the indicated point: • • • A point has been created. The line is now composed of two segments. Coincidence constraints have been created.

4. Click the Break icon: 5. Select the line to be broken.
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6. Select the breaking point.

The line is broken from the projection of the selected point: • • • A projection point of the selected point has been created. The line is now composed of two segments. Coincidence constraints have been created.
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Using the Break command, you can also isolate points: • • if you select a point that limits and is common to two elements, the point will be duplicated. if you select a coincident point, this point becomes independent (is no more assigned a coincidence constraint).

You cannot break composite curves (which are projected/intersected elements composed of several curves). However, you can work around this functional restriction by projecting or intersecting the composite curve elements and break these items using one another.

Breaking/Trimming Use-Edges
This task shows you how to break or trim imported elements (projection, intersection, offset). The created use edge is only changed into construction mode but it is unchanged. For the purpose of this scenario an example of trimming element is used.
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1. Create a conic. 2. Exit Sketche r. 3. In Part design workben ch, create a new sketch based on the conic. 4. Project the conic. 5. Create two lines as shown here. 6. Click the Trim icon from the Operatio ns toolbar.

7. Select the Use Edge between the two lines. 8. Select a first line. An arc is created based on the useedge and the original use-
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When trimming a curve the selected location on the curve is important as it determines the curve part that will be kept.

The mark, which is put in construction mode, and the arc are displayed in the specification tree.

•

When deleting the use edge (projecti on,
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•

•

Trimming Multiple Elements
This task shows you how to trim a few elements using a curve type element. Enter the Sketcher workbench and create as many elements as you wish. 1. Multi-select the elements to be trimmed.
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2. Click the Trim icon: 3. Select the trimming curve to be used.

4. Click to indicate the side of the elements will be kept according to the trimming curve.

Elements have been trimmed. If one element does not intersect the trimming curve, this element will be either totally deleted or kept (in accordance with the location of this
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element). For instance, on the example above, the line above the trimming curve is kept, the line below the trimming curve is deleted.

Transforming
Creating Mirrored Elements
This task shows you how to repeat existing Sketcher elements using a line or an axis. Create a circle and an axis. 1. Select the circle to be duplicated by symmetry.

2. Click the Mirror icon

from the Operation toolbar.

3. Select the axis you previously created. • • The selected circle is duplicated A symmetry constraint is created on the condition you previously activated the Geometrical Constraints option .
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You can also use multi-selection: • • Drag the cursor and create a trap. Select the symmetry axis.

Moving Elements by Symmetry
This task shows you how to move existing Sketcher elements using a line, a construction line or an axis. In this particular case we will move a rectangle by symmetry. The former functionality associated to this command is now available through the Mirror command, which duplicates elements by symmetry.

1. Create a rectangle and an axis.
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2. Click the Symmetry icon from the Transformati on subtoolbar in the Operation toolbar. 3. Select the rectangle and the axis you have created.

The rectangle has been moved by symmetry according to the axis.

Two sides selection
1. Create an axis. 2. Create a rectangle on one side of the Axis and a circle on the other 172

User Tasks side. 3. Click the Symmetry icon from the Transformati on subtoolbar in the Operation toolbar.

4. Select the rectangle and the circle. 5. Select the axis. In order to be able to multi-select elements, the axis length must be quite important.
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The symmetry is created and the two elements have been taken into account.

Applying constraints to symmetrical elements
1. Create a rectangle and an axis. 2. Select the Constraint icon from the Constraint toolbar. 3. Select one of the rectangle element and the axis. 4. Click to create the constraint. The constraint and its value are displayed in the geometry area.
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5. Click the Symmetry icon from the Transformati on subtoolbar in the Operation toolbar. 6. Select the rectangle and the axis.

The rectangle has been moved by symmetry according to the axis. Note that: • As the constraint is applied on an axis, the constraint is kept after the symmetry.

• •

The constraint is also kept when it is applied to a fixed element. In the case of Use-Edges, the element becomes isolated.

Only internal constraints are kept after a symmetry operation.

Translating Elements
This task will show you how to perform a translation on 2D elements by defining the duplicate mode and then selecting the element to be duplicated. Multi-selection is not available.
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The application provides a powerful command for translating elements. You may either perform a simple translation (by moving elements) or create several copies of 2D elements. Translating elements also means re-computing distance, angle and/or length constraint values, if needed. Be careful: only non-fixed elements are updated. Open the Transform_replace01.CATPart document

1. Click the Translation icon: The Translation Definition dialog box appears. It will remain displayed all along your translation creation. The Duplicate mode option is activated by default, which means that the 2D elements you select will be copied. If you uncheck the Duplicate mode option, the element will be moved.

2. Keep the Instance(s) field to 1 and the Duplicate mode option activated. 3. Select the Keep internal constraints option. This option specify that you want to preserve in the translation the internal constraints applied to the selected elements. 4. Keep the Keep external constraints 1 option deactivated. Any external constraint existing between the selected elements and external elements will be disregarded in the translation. 5. Select the elements to be translated using the trap selection.

176

User Tasks

You may either select one 2D element, or multi-select the entire 2D geometry by trapping it with the mouse as shown below. 6. Click to indicate the translation vector starting point.

You can define the translation length in the geometry area, using the mouse. For more precise results, enter a specific value for the translation length in the Translation Definition dialog box. 7. Type 30mm in the length field.

You can use SmartPick to keep lines horizontal. Optionally, you can select the Snap Mode option in the dialog box. • • The translation length is incremented by steps of 5mm by default. To change the default step value, right-click the Value combo
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and choose a predefined step value or define a new one. 8. Click to indicate the translation vector ending point.

9. Click OK in the Translation Definition dialog box. . The translation has been performed.

You can notice that the internal constraints were preserved in the translated element (four tangency constraints, and a parallelism constraint), whereas the external constraint (an offset constraint) was not. • • The Undo command is available from the toolbar, while you are translating elements. When translating external constraints: o geometrical constraints are deleted.. o dimensional constraints are preserved but revalued.

Rotating Elements
This task will show you how to rotate elements by defining the duplicate mode and then selecting the element to be duplicated. In this scenario, the geometry is simply moved. But note that, you can also duplicate elements with the Rotation command.

178

User Tasks

Rotating elements also means re-computing distance values into angle values, if needed. Be careful: only non-fixed elements are updated.

Open the Transform_replace01.CATPart document.

1. Click the Rotation icon from the Operations toolbar (Transformation subtoolbar).

The Rotation Definition dialog box appears and will remain displayed all along the rotation. 2. De-activate the Duplicate mode, if needed. If you keep it active, you will be allowed to define the number of the instances you wish to create in the meantime.

3. Select the geometry to be rotated. Here, multi-select the entire profile.

4. Select or click the rotation center point. You can also enter a value in the fields displayed (Sketch tools toolbar). 5. Select or click a point to define the reference line that will be used for
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6. Select or click a point to define an angle.

• •

If you have check snap mode in the dialog box and set the value to 5 degrees, then when you drag the cursor to rotate the element it rotates by 5 degrees steps. You can also enter a value for the rotation angle in the Rotation Definition dialog box
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7. Click OK in the Rotation Definition dialog box to end the rotation. Rotating elements also means re-computing distance values into angle values, if needed. Be careful: only non-fixed elements are updated.

• •

Internal constraints are preserved External constraints: o geometrical constraints are killed o dimensional constraints are modified and revalued.

Scaling Elements
This task will show you how to scale an entire profile. In other words, you are going to resize a profile to the dimension you specify. Scaling elements also means re-computing distance values, if needed. Note that angle values will not be modified. Be careful: only non-fixed elements are updated. Open the Transform_replace01.CATPart document.

1. Click the Scale icon: You can first select either the geometry or the scaling icon. If you select the Scale icon first, you cannot multi-select elements. 2. Select the elements to be scaled.
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3. Click to indicate the center point on the geometry.

You can define the center point from its coordinates in the Sketch tools toolbar fields. The Scale Definition dialog box appears. 4. Type 2 as Scale Value in the Scale Definition dialog box.
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5. Click OK in the Scale Definition dialog box.

• •

Internal constraints are preserved but revalued. External constraints: o geometrical constraints are deleted. o dimensional constraints are modified and revalued.

Offsets
Offsetting Elements
This task shows how to duplicate an element of the following type: line, arc or circle. You can also duplicate by offset one of the following: an edge, a face (all the boundaries of this face are offset) or a geometrical feature (for example, by selecting a
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Select a topic: • • • • Offset 2D geometry, Use offset tools, Offset 3D geometry, Modify a 3D geometry offset.

Offsetting 2D Geometry
Create a line.

1. Click the Offset icon from the Operations toolbar (Transformation subtoolbar). OR 1. Select the Insert->Operation>Transformation->Offset command from the menu bar. 2. There are two possibilities, depending on whether the line you want to duplicate by offset is already selected or not: • • If the line is already selected, the line to be created appears immediately. If the line is not already selected, select it. The line to be created appears.

3. Select a point or click where you want the new element to be located. The selected line is duplicated. Both lines are parallel.

• •

If you were offsetting circles or arcs, these two circles would be concentric. If the Geometrical Constraints icon is active in the Sketch tools toolbar when offsetting an element, constraints are automatically created, based on the
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Using offset tools
You can also apply one or more offset instances to profiles made of several elements: • • • by using tangency propagation or point propagation, by creating an offset element that is tangent to the first one, by creating several offset instances.

This is not true for generated elements (Generative Drafting workbench). If the multi-selected elements do not make up a closed profile, the offset will be applied to the selected elements only. As a result, you will have as many offset elements as the first multi-selected elements. Previews are not available when creating several offset instances (i.e. when the value in the Instance(s) field of the Sketch tools toolbar is higher than one).

Open the Offset.CATPart document. 1. Click the Offset icon from the Operations toolbar (Transformation subtoolbar).

2. Select the desired option from the displayed Sketch tools toolbar and if needed, enter the desired number of instances. (These options are described further down in this section). 3. Select the element you want to offset. The element to be created is previewed. 4. Select a point or click where you want the new element to be located.

To offset a single element:

Activate the No Propagation icon.
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To offset an element and elements which are tangent to it:

Activate the Tangent Propagation icon.

To offset an element using Point Propagation:

Activate the Point Propagation icon.

To offset an element symmetrically to another:

Activate the Both Side Offset icon.

To offset and duplicate multiple elements:

Type the number of elements you want to create in the Instance(s) field.
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Note that if you position the cursor outside the zone that is allowed for creating a given element, the symbol appears.

Drafting Workbench
You can create offset geometry using 2D component elements and dress-up elements (axis lines, center lines and threads). Note that by doing this, you will not create offset 2D components or dress-up elements, but you will create offset geometry.

• • •

You can offset them only element by element. You cannot offset complex curves. This will only work if you first select the command and then the element to offset.
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Offsetting 3D Geometry
You can create an associative offset with a 3D element. Open the Offsetpad.CATPart document. 1. Click the Offset icon from the Operations toolbar (Transformation subtoolbar).

2. Select the 3D surface to offset, Face.1 for example. The profile to be created is previewed. 3. You can do one of the following: • specify the offset position and value in the Sketch tools toolbar and press Enter to validate.

•

drag the cursor till the correct offset appears in the sketch, then click to validate the position.

The offset is created, with the offset value displayed.
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It appears as Mark.1 in the specification tree:

If you want to edit the offset value, you can double-click it and enter a new value in the dialog box which is displayed.

•

• •

When offsetting a face, if there is an intersection between the face and the sketch plane, by default, it is this intersection which is offset (rather than the projection of the face edges). In this case, if you want to offset the projection of the face edges, you can modify the offset as explained in the section below. You can offset the intersection between a face and a sketch plane without explicitly creating this intersection. lf you offset a multi-domain face, the face that is closer from the cursor is offset. If you isolate a composite mark, as many simple geometry elements as the mark was containing are created, and associativity will not be available anymore.

•
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Modifying a 3D Geometry Offset
1. Double-click the offset in the specification tree or on the sketch. The Offset Definition dialog box is displayed.

In this dialog box, you can modify the offset definition. • Parallel corner type: specifies whether corners should be round or sharp (when applicable).

Note that this option applies only when the offset results in extrapolated curves (as is the case in our example, for instance).

Parameters

These options let you specify the offset parameters. • Object to offset: indicates which 3D element is offset. To offset another
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User Tasks element, select this field and then select the new element in the sketch. Offset value: indicates the offset value. You can modify it by typing a new value in this field. Offset mode: when offsetting a face, specify whether you want to intersect and offset or to project and offset the face by selecting the appropriate option from the list.

• •

Propagation

These options let you offset a 3D element using the propagation of an edge. • • Type: specifies what type of offset propagation should be applied to the selected reference element: No propagation, Tangent propagation, or Point propagation. Click the appropriate icon. Reference element: indicates which edge should be used as a reference for the propagation. Select this field and then select the reference edge in the sketch.

2. In the Offset value field, type 20mm. 3. Choose Project and offset from the Offset mode field. 4. Click OK to validate. The offset is modified.

• • • •

Only 3D elements can be offset with associativity. There is no propagation on 3D edges. Typing a negative offset value reverses the offset direction. Multi-domain elements cannot be offset in one shot.

Creating Spline Offsets
This task shows you how to create an associative offset based on an existing spline. 1. Create a spline. 2. Select the Offset command from the Transformation sub-toolbar in the Operation toolbar
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3. Click the spline. 4. Click in the geometry area to create the offset.

The offset is created as long as a new feature OffsetCurve which is visible in the specification tree. Note that: • The visualization of the offset implies an automatic creation of elements, which are automatically put in no show and construction mode. These elements are put in no show mode only if the Geometrical Constraint option in the Sketch tools toolbar is activated. These elements are also deleted if the offset or the original spline are deleted. The created offset will be associative with the original spline only if the Dimensional Constraint option in the Sketch tools toolbar is activated, see Editing Spline Offset. When creating an offset of a spline, a constraint is automatically created and the offset cannot be deleted.

•

•

•

•
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Projections/Intersections
Projecting 3D Elements onto the Sketch Plane
This task shows how to project edges (elements you select from the 3D area) onto the sketch plane. 1. Click the Project 3D Elements icon: 2. Multi-select the edges you wish to project onto the sketch plane The edges are projected onto the sketch plane. These projections are yellow. You cannot move these elements. To move them, first use the Isolate command.

• •

You can apply the Relimitation

, Corner

and Chamfer

commands on projections. If you select a face, its edges are projected.
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•

• • • •

A canonicity detection is performed on projected curve according to the application tolerance, in other words the application tries to recognize sketcher elements like line or conic curves. Due to the canonicity approximation changes may occur in resulting projected curve types. If no canonicity has been detected the curve is projected as is. Projected elements are associative except in the case of multiple distinct marks. A mark composed of several associated elements is managed as a single curve (you can constraint it). In general, we recommend not to create projections from wireframe elements which lie on a plane orthogonal to the sketch. As a matter of fact, the orientation of the result of these projections in the sketch plane is not stable. If you isolate a composite mark, as many simple geometry elements as the mark was containing are created, associativity will not be available anymore. A multi-domain face projection does not create a single composite mark (in this case each edge is projected).

•

•

Projecting 3D Silhouette Edges
This task shows how to create silhouette edges to be used in sketches as geometry or reference elements. You can only create a silhouette edge from a canonical surface whose axis is parallel to the Sketch plane.
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1. Select Plane1 and go into Sketcher workbench. 2. Click the 3D Silhouette Edges icon from the Operation toolbar (3D Geometry subtoolbar).

3. Select the canonical surface.
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You can select one of the two intersections and set it into the Construction mode:

You can create geometry and constraints using this intersection:

You can re-limit this created silhouette edge using the geometry:
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The silhouette command generated one or two marks (edges) if one mark is made of more that one curves. If those curves do not have the same geometrical support, the resulting silhouette edges will not be associative (as for Projection/Intersection commands). • Silhouette edges are associative except in the case of a multiple distinct marks. • A mark composed of several associated elements is managed as a single curve (you can constrain it).

Intersecting 3D Elements with the Sketch Plane
This task shows how to intersect a face and the sketch plane.

Open the Intersection_Canonic.CATPart document. 1. Select the face
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2. Click the Intersect 3D Elements icon: The application computes and displays the intersection between the face and the sketch plane. The intersection is yellow (in others words, you cannot move it).

• • •

You can apply the Relimitation

, Corner

and Chamfer

commands on projections. If you select a face, its edges are projected. A canonicity detection is performed on projected curve according to the application tolerance, in other words the application tries to recognize sketcher elements like line or conic curves. Due to the canonicity approximation changes may occur in resulting projected curve types. If no canonicity has been detected the curve is projected as is. Intersected element are associative apart in the case of a multiple distinct marks. A mark composed of several associated elements is managed as a single curve (you can constraint it). If you isolate a composite mark, as many simple geometry elements as the mark was containing are created, associativity will not be available anymore. If the intersected geometry is a plane face and there is no intersection between this face and the sketcher plane, the resulting intersection is an infinite line.

• • • •

•

Isolating Projections and Intersections
This task shows how to isolate the elements resulting from the use of the Project 3D Elements or Intersect 3D Elements operations.
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Open the Intersection_Canonic.CATPart document and create an intersection as explained in Intersecting 3D Elements with the Sketch Plane. 1. Select any yellow element obtained from the projection or the intersection. 2. Select Insert -> Operation -> 3D Geometry -> Isolate command from the menu bar or use the Mark.x -> Isolate contextual command.

The elements are no longer linked to the initial geometry, which means that you can edit them the way you wish. 3. For example, drag and drop this curve to the location you want:

Once isolated, the elements are displayed in white. You can edit their graphical properties using the Edit -> Properties command.

Copying/Pasting Elements
This task shows how sketched elements behave when you copy and paste
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them. More specifically, you will learn about: • • • Copying/pasting elements with H and V constraints on their absolute axis Copying/pasting projected or intersected elements Copying Sketches

For general information on copy/paste, see the Infrastructure User's Guide.

Copying/pasting elements with H and V constraints on their absolute axis
This task shows how to copy/paste elements along with the horizontal and vertical constraints on their absolute axis. Open the Copy_paste_H_and_V.CATPart document. 1. To duplicate the rectangle and its H and V directions: multi-select the rectangle and its origin, and copy the selected elements

1. To duplicate the rectangle, its H and V directions, and the distance constraints which exist between the rectangle and its origin: multiselect the rectangle and the distance constraints (do not select the origin), and copy the selected elements.
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In other words, if you want to copy an element along with its H and V direction while keeping the constraints which exist between the copied element and its origin, you do not need to, and you should not, select the origin. Selecting the constraints is enough. If you select the origin, the constraints will not be kept. 2. Paste these elements. The elements are pasted over the elements you copied. You can move the pasted elements (if you want to view them, for example).

Copying/pasting projected or intersected elements
This task shows how sketched elements that were created via projection or intersection behave when copying/pasting them. 1. Copy the projected or the intersected element, using the method described above. 2. Paste this element. External references are deleted: • • • • Constraints on external geometry are deleted. Projections/Intersections are isolated: each trace is replaced with an equivalent geometrical element. You cannot project or intersect the pasted element. The pasted element is not associative.

Copying Sketches
This task shows how pasted sketches behave. 1. Create a sketch then enter Part Design workbench. 2. Copy and paste the sketch using the Paste Special contextual command and the As Result with Link option.

The sketch is pasted. You can observe a blue symbol added to the
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image of the sketch in the specification tree, meaning that associativity is maintained between the reference geometry and the copy.

3. Use this copied sketch to create a pad. 4. Just edit the reference sketch the way you want: for example, change the shape. The pad reflects the change. In the specification tree, sketches copied and pasted in documents different from the documents in which they were created are identified by a green point in target documents:

The green point is turned into a red cross when the copied sketch needs synchronizing with its reference:

Performing a Quick Geometry Diagnosis
This task explains how to display a quick diagnosis of a sketch geometry. You will be provided an overall status of the sketch geometry as a whole, so that can correct any constraint-related problem accordingly. Open the Sketch_Analysis.CATPart document. 1. Click the Sketch Solving Status in the icon Tools toolbar (2D Analysis Tools subtoolbar).
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The Sketch Solving Status dialog box is displayed. It indicates the overall status of the sketch geometry. In this case, the sketch is under-constrained.

•

•

On the sketch as well as in the specification tree, under-constrained and over-constrained geometrical elements (lines, points, etc.) are highlighted, and iso-constrained elements are displayed in a different color. This enables you to see easily which items are under/ overconstrained, and which are iso-constrained. In our example, all geometrical items are under-constrained; they are therefore displayed in red. There is a tangency constraint which is isoconstrained; it is displayed in green. in the dialog box If you wish, you can click the Sketch Analysis icon to view a more in-depth diagnosis specifying which individual geometrical elements in the sketch are under-constrained (underdefined), over-constrained (over-defined) or iso-contrained (well defined).

•

2. Click the Close button to close the Sketch Solving Status dialog box. 3. From the specification tree, expand the Sketch.1 and then the Geometry nodes. 4. Multi-select all items under the Geometry node, and right-click them. 5. Select Selected objects > Fix from the contextual menu. All elements are now fixed.
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6. Click the Sketch Solving Status again. The icon Sketch Solving Status dialog box now indicates that the sketch is isoconstrained.

Analyzing the Sketch
This task explains how to analyze sketched geometry as well as projections/intersections, and how to diagnose geometry. You will be provided either a global or individual status and will be allowed to correct any problem stated in the status.

Analyzing sketched geometry
Open the Sketch_Analysis.CATPart document. 1. OR 1. Click the Sketch Analysis in the icon Tools toolbar (2D Analysis Tools subtoolbar). The Sketch Analysis dialog box appears. It contains three tabs: Geometry, Projections / Intersections and Diagnostic. Select Tools -> Sketch Analysis from the menu bar.
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2. Click the Geometry tab.

The information on this tab helps you to know whether the sketch geometry is valid. General Status: analyzes several elements globally. Detailed Information: provides a detailed status/comment on each geometrical element of the sketch. Corrective Actions: according to the analyzed element you select and which is not correct, you will be able to: • • • turn this element into a construction element, close a profile that is not, erase a disturbing element,
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3. In the Detailed Information table, select the Point.11 item and then click the Construction mode icon to turn the standard mode point into a construction mode point and solve the problem.

Diagnosing geometry

4. Click the Diagnostic tab.

The information on this tab displays a full diagnosis of a sketch geometry. It provides a global analysis of the sketch as a whole, and specifies whether individual geometrical elements in the sketch are under-constrained (underdefined), over-constrained (over-defined) or iso-contrained (well defined): Solving Status: provides a quick overall analysis of the sketch geometry.
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Detailed Information: provides a detailed status on each constraint and geometrical element of the sketch, and lets you know what type of element it is (geometry, constraint). Actions: according to the analyzed element you select, you will be able to: • • hide all constraints on the sketch and in the detailed information area, hide all construction geometries on the sketch and in the detailed information area of the Diagnostic tab.

If you select items from the Detailed Information table, they will be highlighted on the sketch, which enables you to identify them easily. To solve constraintbased problems in the sketch, you need to edit the sketch directly. 5. Close the Sketch Analysis dialog box. 6. Right-click the Point.3 item in the sketch or from the specification tree, and select Point.3 object > Fix from the contextual menu. 7. Repeat this operation for the Line.1, Circle.1, Line.2 and Point.8 items. 8. Re-open the Sketch Analysis dialog box and click the Diagnostic tab. You can notice that the items you fixed are now isoconstrained.

Analyzing projections/intersections

Open the Analyse.CATPart document.
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The information on this tab lets you know the status of all use-edges: projections (implicit or non-implicit), intersections, etc... Detailed Information: provides a detailed status/comment on each projection or intersection, on constraints and so forth. Corrective Actions: according to the analyzed element you select and which is not correct, you will be able to: • • • • • • isolate geometry activate/deactivate a constraint erase geometry replace 3D geometry hide all constraints on the sketch, hide all construction geometries on the sketch and in the detailed information area of the Projections/Intersections tab.

You can see that all construction and intersection elements for this part have a valid status so you don't have to do anything.

Editing Sketches
Editing Sketches
The Sketcher workbench provides a set of functionalities for editing 2D geometry. To Edit an Existing Sketch: • Double-click the sketch or an element of the sketch geometry, either in the geometry area or in the specification tree.
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•

To do this from the 3D, right-click the sketch in the specification tree, point to [sketch name] object in the contextual menu, and then select Edit.

Modifying Element Coordinates: Double-click to modify the sketch coordinates and thereby modify the feature defined on this sketch. Performing Auto-Search on a Profile: Use the menu bar to auto-search for the different elements of a profile. Transforming Profiles: Use selection to edit the profile shape and size, modify the profile location (via external constraints). Editing Conic Curves: Double-click the conic to edit it. Editing a Connecting Curve: Double-click the connecting curve to edit it. Editing a Spline: Double-click the spline to edit it. Editing Spline Offsets: Double-click the offset constraint to edit it. Editing an element Parents/Children and Constraints: Right-click on the element end select Parents/Children... option in the contextual menu. Editing Projection/Intersection Marks: Edit Projection/Intersection Marks definition and modify their import properties. Replacing Geometry: Replace geometry in the 2D and visualize it in the 3D. Deleting Sketcher Elements: Use selection to delete elements.

Modifying Element Coordinates
This task shows you how to modify a line. Modifying your sketch coordinates will affect the feature defined on this sketch. In other words, associativity remains valid. Create a line. Profiles are not considered as entities when it comes to editing them. To edit a profile, you will need to edit the sub-elements composing it. Multi-selection is not allowed for editing Sketcher elements.

1. Double-click the line you wish to edit. The Line Definition dialog box appears indicating the line end point coordinates. 2. Enter new coordinates for changing the end points and/or the length and angle. 3. Check the Construction Elements option, if you wish to change the line type. 4. Press OK.
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Remember that the Edit -> Properties command, or Properties option in the contextual menu lets you access and edit sketch properties (properties dialog box)

Performing Auto-Search on Profiles
This task shows how to auto-search for the different elements of a profile. Open the Auto_Search.CATPart document. 1. Select one element of the whole profile. 2. Select Edit -> Auto Search from the menu bar. Element selected: Resulting auto-searched profile:

The unambiguous part of the profile is highlighted.
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Transforming Profiles
This task shows you how to: • • • transform profile shape and size using the Selection command. transform a profile position according to a pre-defined solving mode. transform a profile position using existing external constraints.

Open the Transform_replace01.CATPart document.

Transforming By Moving
Minimum Move
You will move as few elements as possible. Go to Tools -> Options -> Sketcher (Solving mode switch button) and make sure you activated the Minimum move option from the Dragging of the element dialog box.
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1. Click the Select icon:

2. Drag the right line of the profile anywhere to the right. The profile is stretched to the right if you stretch it to the right.

3. Click one corner of the profile and stretch this profile diagonally.

Standard Mode
You will move as many elements as possible. Go to Tools -> Options -> Sketcher (Solving mode switch button) and make sure you activated the Standard mode option from the Dragging of the element dialog box. 1. Click the Select icon:
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2. Drag the right line of the profile anywhere to the right. The profile is stretched both to the right and to the top even if you stretch it to the right.

Relaxation
Go to Tools -> Options -> Sketcher (Solving mode switch button) and make sure you activated the Relaxation option from the Dragging of the element dialog box. • • • You can also edit the profile shape and size using commands such as and break . edit, trim If you want the profile to revert to its original shape, click the Undo . command If the Grid option is on (Tools -> Options -> Sketcher), you can also modify the profile using the grid. In this case, and for example if the Zoom is on, the point you select will be automatically repositioned at the closest grid intersection point. The profile new position may result awkward.

Transforming Using Constraints
1. Click the Select icon: 2. Double-click the offset constraint.
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The Constraint Definition dialog box appears. 3. Type 20mm as new value.

The external constraint is re-computed and the geometry is repositioned.

Curves
Editing Conic Curves
This task shows how to edit Conic Curves.
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1. Double-click the conic you want to edit.

Changing the conic parameters
The Conic Curve Definition dialog box is displayed. 2. Enter the new parameters you wish to apply to the conic curve. You can edit the following options as displayed in the dialog box.
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sketcher Constraint Limits: • Start and End Points: the curve is defined from the start point to the end point. Start and End Tangents: if needed the tangent at Start or End points can be defined by selecting a curve. Tangent intersection point: indicates the point used to define both Start and End tangents. These tangents are on construction lines passing through Start or End points and the selected point. Point: defines a point when checking the Tangent intersection point option.

•

•

•

Note that you will have to choose 216

User Tasks either a start and end tangents or a tangent intersection point.

Intermediate Constraints: • Parameter: defines the value of the parameter. Ratio ranging from 0 to 1 (excluded), which value is used to define a passing point ( M in this figure) and corresponds to the OM distance/OT distance. If the parameter
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sketcher = 0.5, then the resulting curve is a parabola. If 0 < parameter < 0.5, then the resulting curve is a an arc of ellipse. I1> parameter > 0.5, then the resulting curve is a hyperbola. Points 1, Point 2, Point 3: defines the possible passing points of the conic. These point have to be selected in logical order after having define the Start an End points. Tangent 1, Tangent 2: defines the tangency when it is applied to one of the passing points.

•

•

Applying constraints between the conic and another geometrical element
1. For instance, create a conic and a circle.
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2. Click the Constraint icon from the Constraint toolbar. 3. Select the two elements. 4. Right click the second element. 5. Select Tangency.

The tangency has been applied to the two selected elements.

Inconsistent conics
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Editing Connecting Curves
This task shows you how to edit a curve which connects two elements of the curve type. Open the Edit_Connecting_Curves.CATPart document.
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1. Double-click the connecting curve you want to edit. Red arrows indicating tangency directions are now displayed at each extremity point.

The Connect Curve Definition dialog box is displayed. For each support curve, you can edit the following options as appropriate: • • • Point: defines the extremity point (on the support curve) of the connecting curve. Curve: defines the support curve for the connecting curve. Continuity: indicates whether the connecting curve is continuous in point, in curvature or in tangency with the support curves. Tension: when the connecting curve is continuous in curvature or in tangency, specifies the tension which is applied to it. Reverse Direction: when the connecting curve is continuous in curvature or in tangency, reverses its direction.

•

•

221

sketcher

2. For the first support curve, select Tangency from the Continuity field and set the tension to 3.

3. To reverse tangency directions you can now click both red arrows available when editing. This is equivalent to clicking the Reverse Direction button from the dialog box. For the purpose of our scenario, click the left arrow. You must obtain this: 4. For the second support curve, click the Point field, then select another extremity point (CtrlPoint.4 for example).
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5. When you are satisfied with your modifications, click OK to validate and exit the dialog box.

Editing a Spline
This task shows you how to edit spline properties and then modify, add or remove spline control points. Create a spline such as the one shown below.

Adding a point
To add a point, you have several possibilities, depending on whether you want to add an existing point, or create the point on the sketch while editing the spline. 1. Double-click on the spline, or go to Edit -> Spline.1 object -> Definition.... The Spline Definition dialog box appears.
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•

To add an existing point (i.e. a point created prior to editing the spline):

1. In the dialog box, select the spline point after or before which you want to add a point. Select CtrlPoint.2 for example. 2. Then, choose Add Point After or Add Point Before (depending on whether you want to add a point after or before the selected point). Select Add Point After for example. 3. Finally, click on the existing point you want to add in the spline.

If you proceed as shown below, for example:

You will get this result:
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•

To create the point on the sketch while editing the spline: 1. In the dialog box, select the spline point after or before which you want to add a point. Select CtrlPoint.2 for example. 2. Then, choose Add Point After or Add Point Before (depending on whether you want to add a point after or before the selected point). Select Add Point After for example. 3. Finally, click on the sketch, at the location where you want to add the new point.

If you proceed as shown below, for example:

You will get this result:

225

sketcher

Replacing a point
2. To replace a point, select the spline point that you want to replace in the dialog box, then select the Replace Point option, and finally click on the sketch, at the location where you want to add the new point. If you proceed as shown below, for example:

You will get this result:

Closing a spline
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You can edit existing splines which are closed using a continuity in point at the closure point: selecting the Close spline option will make such splines continuous in curvature at the closure point.

Removing a point
1 . Select the point that you want to remove in the dialog box. 2. Click the Remove Point button. 3. Click OK.

Defining a tangent
1. Select the point you want to add a tangent in the dialog box. 2. Check the Tangency option. A tangent appears, you can reverse it clicking on the Reverse Tangent button. 3. If needed, check the Curvature Radius option and key in the value.
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Editing Spline Offsets
This task shows you how to edit an Offset based on an existing spline, or even the offset constraint. 1. Create a Spline Offset.

Editing the offset constraint
2. Double-click the constraint to change its value.

The Parameter Definition dialog box is displayed. 3. Enter the value you want to apply for
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The constraint value has been modified. The constraint cannot be deleted.

Editing the spline offset
1. Create a Spline Offset. 2. Double-click the spline offset. The Offset Definition dialog box is displayed. 3. Change to the parameter you want to apply. The spline offset is associative to the original spline in such a way that for instance: • • when deleting the spline, the offset spline is displayed in red to show that there is an update error. when adding control point to the original spline, the offset spline is automatically updated.

Editing Parents/Children and Constraints

229

sketcher

This task shows you how to edit an element Parents/Children and Constraints. Open the Analyse.CATPart document. 1. Edit the Sketch.2 2. Right-click the Offset.12 constraint and select Parents/Children... from the contextual menu. The Parents and Children dialog box appears.

You can in this dialog box: • • Double-click an element to expand its parents. Right-click an element and select any relative items about parent and children display from the contextual menu.

Editing Projection/Intersection Marks
This task shows you how to edit Projection or Intersection marks. Open the Analyse2.CATPart document. 1. Double-click the Mark.1 element.
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The Import Definition dialog box appears and lets you change the element which is used as a reference for this mark.

2. Make sure the Reference Element field is active, and select the arc as new reference element.

3. Click OK in the Import Definition dialog box. The mark reference and position are changed.
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Replacing Geometry
This task shows how to replace 2D geometry. Note that: • • You replace a geometrical element with another on the 2D (Sketcher workbench) but no modification occurs in the 2D. Only the 3D geometrical elements which used the replaced 2D geometrical elements will be modified. You can visualize the modifications when entering Part Design workbench.

Open the Replace.CATPart document.
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1. Edit the Sketch.1 2. Right-click the element to be replaced.

3. Select the Line.2 object -> Replace... command from the contextual menu. The Replace dialog box appears.

4. Select Line.1
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The Replace dialog box now appears as shown here: Line2 will be replaced with Line1.

The geometry is unchanged and appears as shown here:

5. Click OK. 6. Click the Exit icon .

The pad (created via the 2D geometry) is modified.
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7. Close the document and reopen it. 8. Create a three points Arc on the sketch geometry.

9. Select the Line.1 object -> Replace... command from the contextual menu. 10. Select the arc created. 11. Select the Delete replaced elements and exclusive parents option in the Replace dialog box and click OK.
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12. Click the Exit icon

.

The pad (created via the 2D geometry) is modified.

Deleting Sketcher Elements
This task shows how to delete sketched elements. Deleting sketched elements affects associated features. This what we call propagation: • If you delete a curve (assigned endpoints, by default), the endpoints will also be deleted on the condition they are not part of a constraint or common to another curve. Curves are assigned endpoints and circle or arcs are assigned center points, by default. If you delete a curve and the endpoints/center point, these points will be actually deleted is they are not either part of a constraint or common to another element. Propagation is not valid for constraints: if you delete a constraint, you

• •
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will not delete the corresponding geometry. Create a sketch profile. 1. Select the element you wish to delete.

2. Click the Edit -> Delete command. The element is deleted.

2. If you wish to delete a set of elements, just multi-select them and apply the Delete command.
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• •

You can also select the Delete command from the contextual menu. For this right-click the element to be deleted. In case you created an element using the Sketch tools toolbar options, constraints are applied to this element: o If you delete this element, associated constraints will be too. o Conversely if you delete one, several or all the associated constraints, the element will be not delete.

You cannot delete elements that are not currently edited sketch elements. This is particularly true for the reference planes. You can multi-select these elements but they will not be deleted.

Sketching Pre-Defined Profiles
Sketching Pre-Defined Profiles
The Sketcher workbench provides a set of functionalities for creating 2D geometry and more precisely pre-defined profiles. • • Before you begin, make sure you are familiar with Tools For Sketching. You can sketch pre-defined profiles either via the corresponding icons or via the menu bar (Insert -> Operation -> Predefined Profiles).

Creating Oriented Rectangles: Use the Sketch tools toolbar or click to define a first side for the rectangle and then a point corresponding to the rectangle length. Creating Parallelograms: Use the Sketch tools toolbar or click to define a first side for the parallelogram and then a point corresponding to the parallelogram length. Creating Elongated Hole: Use the Sketch tools toolbar or click two points to define the axis and then a point corresponding to the elongated hole width. Creating Cylindrical Elongated Hole: Use the Sketch tools toolbar or click a point to define the center, two points to define the arc of circle as circular axis and then a point corresponding to the cylindrical elongated hole width.
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Creating Keyhole Profiles: Use the Sketch tools toolbar or click to define the center to center axis and then both points corresponding to both radii. Creating Hexagons: Use the Sketch tools toolbar or click to define the hexagon center and dimensions. Creating Centered Rectangles: Use the Sketch tools toolbar to define the rectangle center and dimensions. Creating centered Parallelograms: Use the Sketch tools toolbar to define a first side for the parallelogram and then a point corresponding to its length.

Creating Oriented Rectangles
This task shows how to create a rectangle in the direction of your choice by defining three extremity points of the rectangle. In this task, we will use the Sketch tools toolbar but, of course you can create this oriented rectangle manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. Enter the Sketcher workbench.

1. Click the Oriented Rectangle icon: The Sketch tools toolbar now displays values for defining the first side of the oriented rectangle (both points) and then either one point on the second side or directly the oriented rectangle height. 2. Type in the Sketcher tools toolbar for the first corner: H=20mm, V=20mm and press Enter.

3. Type in the Sketcher tools toolbar for the second corner: W=20mm, A=25deg and press Enter.
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4. Type in the Sketcher tools toolbar for the third corner: Height=-22mm and press Enter.

The oriented rectangle is created and corresponding constraints appear as shown here.
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Creating Parallelograms
This task shows how to create a parallelogram by clicking. In this task, we will use the Sketch tools toolbar but, of course you can create this parallelogram manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. Enter the Sketcher workbench.

1. Click the Parallelogram icon: The Sketch tools toolbar now displays values for defining the first point of the parallelogram. 2. Type in the Sketcher tools toolbar for the first corner: H=20mm, V=20mm and press Enter.

3. Type in the Sketcher tools toolbar for the second corner: H=37mm, V=10mm and press Enter.
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4. Type in the Sketcher Tools toolbar for the third point: H=57mm, V=10mm and press Enter.

The parallelogram and corresponding constraints appear as shown here.

Creating Elongated Holes
This task shows how to create an elongated hole by clicking. In this task, we will use the Sketch tools toolbar but, of course you can create this elongated hole manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish.

1. Click the Elongated Hole icon from the Profiles toolbar (Predefined Profile sub-toolbar).

The Sketch tools toolbar now displays values for defining the elongated hole center to center axis (first and second center point) and then either the elongated hole radius or a point on this elongated hole. 2. Position the cursor in the desired field (Sketch tools toolbar) and key in the desired values.
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First Center

Second Center

For example, key in the coordinates of both center points of the elongated hole: a first point (H: 20mm and V: 18mm) and a second point (H: 50mm and V: 18mm). You just defined the profile major axis using points. What you can also do is enter both the length and angle of this axis.

Point on Oblong Profile

For example, key in the coordinates of a point on the elongated hole (H: 53mm and V: 10mm). In other words, you just defined the profile minor axis or the elongated hole width applying a given radius to the profile extremity. At this step, what you can also do is enter the elongated hole radius. The elongated hole appears as shown here.

243

sketcher

Creating Cylindrical Elongated Holes
This task shows how to create a cylindrical elongated hole. A construction arc assists you in creating this element. In this task, we will use the Sketch tools toolbar but, of course you can create this cylindrical elongated hole manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. Enter the Sketcher workbench.

1. Click the Cylindrical Elongated icon: The Sketch tools toolbar now displays values for defining the cylindrical elongated hole. 2. Type in the Sketcher tools toolbar for the circle center: H=20mm, V=20mm and press Enter.

The center point will be used to create both the big radius (radius and angle of the cylindrical elongated hole) and the small radius (circular extremities used to define the cylindrical elongated hole). 3. Type in the Sketcher tools toolbar for the arc start point : H=30mm, V=10mm and press Enter.

The arc appears as a construction arc.
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At this step, you may also define the arc big radius R and angle A. 4. Locate the cursor close to H=10mm and V=30mm 5. Type in the Sketcher tools toolbar for the arc end point : H=10mm and press Enter.

At this step, you cannot define the arc big radius R and angle A. 6. Type in the Sketcher tools toolbar for the point on cylindrical elongated hole: H=40mm, V=18mm and press Enter.
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In other words, you are defining what we call the small radius (Radius: 5.958mm). This small radius corresponds to the width of the cylindrical elongated hole, relatively to the circle center.

Creating Centered Rectangles
This task shows you how to create a centered rectangle. Enter the Sketcher workbench: • Ensure that the Geometrical Constraints Constraints options are deactivated. and the Dimensional

1. Click the Centered Rectangle icon: 2. Click a point in the geometry area or select an existing one.
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3. Drag the cursor to create the centered rectangle.

Applying Constraints
4. Activate the Geometrical Constraints option Constraints option 5. Click the Centered Rectangle icon: 6. Click a point in the geometry. 7. Drag the cursor to specify the rectangle dimensions. and the Dimensional
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• •

Equidistant constraints are applied automatically on the opposed lines accordingly to the center point. Dimensional and Geometrical constraints are activated by default.

Creating Centered Parallelograms
This task shows you how to create a centered parallelogram. Enter the Sketcher workbench and create two lines. • Ensure that the Geometrical Constraints Constraints options are deactivated. and the Dimensional

1. Click the Centered Parallelogram icon: 2. Select a first line (or an axis). 3. Select a second line (or an axis). 4. Drag the cursor to specify the rectangle dimensions.
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The parallelogram is created: • • it is centered on the intersection point of the two lines. its edges are parallel to the selected lines.

Applying Constraints
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5. Activate the Geometrical Constraints option Constraints option 6. Click the Centered Parallelogram icon: 7. Select the two lines one after the other.

and the Dimensional

8. Drag the cursor to specify the rectangle dimensions.

•

•

Two parallelism constraints are created as long as two symmetrical constraints which are based on the two lines selected before the parallelogram creation. Dimensional and Geometrical constraints are activated by default.

Sketching Simple Profiles
Sketching Simple Profiles
The Sketcher workbench provides a set of functionalities for creating 2D
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Before you begin, make sure you are familiar with Tools For Sketching. As soon as a profile is created, it appears in the specification tree. Note that if you position the cursor outside the zone that is allowed for creating a given element, the symbol appears.

Creating a profile: Use the Sketch tools toolbar or click to define lines and arcs which the profile may be made of. Creating a rectangle: Use the Sketch tools toolbar or click the rectangle extremity points one after the other. Creating a circle: Use the Sketch tools toolbar or click to define the circle center and then one point on the circle. Creating a three point circle: Use the Sketch tools toolbar or click to define the circle start point, second point and end point one after the other. Creating a circle using coordinates: Use the Circle Definition dialog box to define the circle center point and radius. Creating a tri-tangent circle: Click three elements one after the other to create a circle made of three tangent constraints. Creating an arc: Use the Sketch tools toolbar or click to define the arc center and then the arc start point and end point. Creating a three point arc: Use the Sketch tools toolbar or click to define the arc start point, second point and end point one after the other. Creating a three point arc (using limits): Use the Sketch tools toolbar or click to define the arc start point, end point and second point one after the other. Creating a spline: Click the points through which the spline will go. Connecting curves with a spline: Click the first, and then the second element to connect. Connecting curves with an arc: Click the first, and then the second element to connect. Creating an ellipse: Use the Sketch tools toolbar or click to define the ellipse center, major semi-axis and minor semi-axis endpoints one after the other. Creating a parabola: Click the focus, apex and then the parabola two extremity points. Creating a hyperbola: Click the focus, center and apex, and then the hyperbola two extremity points. Creating a conic: Click the desired points and excentricity for creating an ellipse, a circle, a parabola or a hyperbola, using tangents, if needed. Creating a line: Use the Sketch tools toolbar or click the line first and second points. Creating an infinite line: Use the Sketch tools toolbar or click the infinite line first and second points.
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Creating a bi-tangent line: Click two elements one after the other to create a line that is tangent to these two elements. Creating a bisecting line: Click two lines. Creating a line normal to a curve: Click a point and then the curve. Creating a symmetrical extension: Use the Sketch tools toolbar or click the center point and then the extremity point of a line that is a symmetrical extension to an existing one. Creating an axis: Use the Sketch tools toolbar or click the axis first and second points. Creating a point: Use the Sketch tools toolbar or click the point horizontal and vertical coordinates. Creating a point using coordinates: Enter in the Point Definition dialog box cartesian or polar coordinates. Creating an equidistant point: Enter in the Equidistant Point Definition dialog box the number and spacing of the points to be equidistantly created on a line or a curve-type element. Creating a point using intersection: Create one or more points by intersecting curve type elements via selection. Creating a point using projection: Create one or more points by projecting points onto curve type elements.

Creating Profiles
This task shows how to create a closed profile. A profile may also be open (if you click the profile end point in the free space). Profiles may be composed of lines and arcs which you create either by clicking or using the Sketch tools toolbar. Enter the Sketcher workbench.

1. Click the Profile icon: The Sketch tools toolbar now displays values for defining the profile. Three profile mode options are available: • • • Line: Tangent Arc: Three Point Arc:

Line is the default mode. 2. Type in the Sketcher tools toolbar for the first point: H=30mm, V=40mm and press Enter.
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3. Type in the Sketcher tools toolbar for the end point: H=70mm, V=40mm and press Enter.

The line appears as shown here, with the constraints corresponding to the line created via the Sketch tools toolbar options.

Note that at this step, you may also enter length L and angle A values. 4. Select the Tangent Arc option: A rubberbanding arc follows the cursor, showing the tangent arc to be created.

When you sketch a profile using the cursor (in other words without using the Sketch tools toolbar fields) to define the end point of the current line or arc, and before clicking this end point, you can hold the CTRL key then click the end point to activate the Tangent Arc mode. A rubberbanding rectangle appears representing the arc of circle. 5. Click to indicate the arc end point.
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Tangent arcs are always positioned in the direction of the element previously created.

The default mode is back to Line. 6. Start dragging another line.

7. Click to indicate the line end point.

8. Click the Three Points Arc mode:
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9. Click to indicate a point which the profile is going to go through (arc second point).

10. Click the start point of the line first created. You thus define the three point arc end point.

The profile results as shown here:
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Creating Rectangles
This task shows how to create a rectangle. In this task, we will use the Sketch tools toolbar but, of course you can create this rectangle manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. Enter the Sketch workbench.

1. Click the Rectangle icon: The Sketch tools toolbar now displays values for defining the rectangle. See Using Tools for Sketching. 2. Position the bottom-left point at: H=20mm, V=20mm

3. Position the top-right corner from the first point: Width=40mm, Height=25mm
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The rectangle is created. Constraints are similarly assigned to this rectangle on the condition you previously activated the Dimensional Constraints option Sketch tools toolbar. in the

As a result, to modify the position of this rectangle, you will perform as follows: 4. Double-click the constraint corresponding to the value to be modified. The Constraint Definition dialog box appears.

5. Enter 50mm and click OK.
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Creating Circles and Arcs
Creating Circles
This task shows how to create a circle. In this task, we will use the Sketch tools toolbar but, of course you can create this circle manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. By default, circle centers appear on the sketch. In case you create circles by clicking, if you do not need them, you can specify this, see Create circle and ellipse centers in Sketcher option. Enter the Sketcher workbench.

1. Click the Circle icon: The Sketch tools toolbar now displays values for defining the circle. 2. Type in the Sketcher tools toolbar for the circle center: H=30mm, V=30mm and press Enter.

3. Type in the Sketcher tools toolbar for the point on circle: R=20mm and press Enter.
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The circle is created. Constraints are similarly assigned to this circle on the condition you previously activated the Dimensional Constraints option Sketch tools toolbar. in the

4. Double-click to edit the offset constraint corresponding to the radius. The Constraint Definition dialog box appears.

5. Select Diameter in the Dimension combo list and click OK. The offset constraint type has been changed to diameter.
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Copying the Circle Radius Parameters
Once you have created one circle, you can create any other and in the meantime use the radius parameter from the circle first created. To do this: 6. Click the Circle icon: 7. Right-click the first circle and select Parameter -> Copy Radius from the contextual menu. The new circle is automatically created with the radius of the circle first created but not positioned. 8. Click to indicate the second circle location or use the Sketch tools toolbars to specify the circle center. The new circle is positioned.

Changing the Circle Radius
Once you have created a circle, you can change its radius. To do this, you can:
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•

•

If the offset constraint corresponding to the radius exists: o Double-click the offset constraint and modify the radius value in the Constraint Definition dialog box that appears. Otherwise: o Double-click the circle and modify the radius value in the Circle Definition dialog box that appears. o Drag the circle until you are satisfied with its new radius.

If the circle center is fixed (or iso-constrained), you can change the circle radius by using one of the methods explained above.

Creating Three Points Circles
This task shows how to create a circle that goes through three points. In this task, we will use the Sketch tools toolbar but, of course you can create this circle manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish.

By default, circle centers appear on the sketch. In case you create circles by clicking, if you do not need them you can specify this in the Options dialog box.

For this, go to Tools>Options, Mechanical Design -> Sketcher option (Sketcher tab).

1. Click the Three Point Circle icon from the Profiles toolbar (Circle subtoolbar).
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The Sketch tools toolbar will display one after the other the values for defining the three points of the circle: values for First Point (H: 10mm and V: 10mm) defining the horizontal (H) and vertical (V) values of a Second Point (H: 50mm and V: 20mm) point on the circle or else the radius of this circle. 2. Position the Last Point (H:30mm and V: 50mm) cursor in the desired fields and key in the desired values.
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The three point circle appears as shown here:

Creating Circles Using Coordinates
This task shows how to create a circle using center point coordinates. In this particular case, we will use cartesian coordinates. Still, you can also use polar coordinates. By default, circle centers appear on the sketch. In case you create circles by clicking, if you do not need them, you can specify this, see Create circle and ellipse centers in Sketcher option. Enter the Sketcher workbench.

1. Click the Circle Using Coordinates icon: The Circle Definition dialog box appears. The default point coordinates that appear in the Circle Definition dialog box are the origin axis coordinates. The default circle radius is 10mm
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If, before clicking the Circle Using Coordinates icon, you select an existing point, this point will be used as a reference point and the coordinates of the center point will be set from this point. 2. Type in the Circle Definition dialog box for the circle center point: H=25mm, V=30mm and Radius=14mm 3. Click OK. The circle and its center point are created.

Creating a Tri-Tangent Circle
This task shows how to create a tri-tangent circle by creating three tangents. By default, circle centers appear on the sketch. In case you create circles by clicking, if you do not need them, you can specify this, see Create circle and ellipse centers in Sketcher option. Enter the Sketcher workbench and create two circles an a line.
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1. Click the Tri-Tangent Circle icon: The Circle Definition dialog box appears. The default point coordinates that appear in the Circle Definition dialog box are the origin axis coordinates. The default circle radius is 10mm 2. Select the first circle.

3. Select the second circle.
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4. Select the line.

The tri-tangent circle is created.
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Constraints are similarly assigned to this circle on the condition you previously activated the Geometrical Constraints option Sketch tools toolbar. • • in the

If you select a point the created constraint is a coincidence. As there are several tangencies for a considered curve (circle, conic, spline, etc), tangent is created as close as possible to where you clicked on the curve.

Creating Arcs
This task shows how to create an arc. In this task, we will use the Sketch tools toolbar but, of course, you can create this arc manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. By default, arc centers appear on the sketch and are associative. In case you create arcs by clicking, if you do not need them you can specify this in the Options dialog box. For this, go to Tools->Options, Mechanical Design -> Sketcher option at the left of the dialog box (Sketcher tab).

1. Click the Arc icon from the Profiles toolbar (Circle subtoolbar).
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The Sketch tools toolbar now displays values for defining one after the other the arc center point, start point and end point. 2. Position the cursor in the desired field (Sketch tools toolbar) and key in the desired values. Arc Center

Start Point

For example, enter H: 18mm and V: 30mm (Circle Center) and then H: 40mm and V: 40mm (Start Point). The arc center and start point appear.

The arc will now appear according to the position you assign to the cursor. In this particular case, the cursor position is at the bottom extremity of the arc. End Point
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For example, enter S: -70deg (Angular Sector). The arc appears as shown here.

Creating Three Points Arcs
This task shows how to create an arc using three reference points in order to define the required size and radius. In this task, we will use the Sketch tools toolbar but, of course you can create this arc manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish.

By default, arc centers appear on the sketch and are associative. In case you create arcs by clicking, if you do not need them you can specify this in the Tools->Options dialog box. For this, go to Tools->Options, Mechanical Design -> Sketcher option at the left of the dialog box (Sketcher tab)

1. Click the Three Point Arc from the Profiles icon toolbar (Circle subtoolbar).

The Sketch tools toolbar will display one after the other values for defining the three points of the circle: defining the horizontal (H) and vertical (V) values of three points on the arc.
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Second Point (H: 27mm and V: 17mm)

End Point (H: 12mm and V: 7mm)

The arc results as shown here.

Creating Three Points Arcs Using Limits
This task shows how to create a three point arc by starting creating the arc limits first. In this task, we will use the Sketch tools toolbar but, of course you can create this arc manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish.

By default, arc centers appear on the sketch and are associative. In case you create arcs by clicking, if you do not need them you can specify this in the Options dialog box.
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1. Click the Three Point Arc Starting with Limits icon from the Profiles toolbar (Circle subtoolbar). The Sketch tools toolbar will display one after the other values for defining the three points of the circle: values for defining the horizontal (H) and vertical (V), values for defining the arc start, end or second points or else the radius of this arc.

2. Position the cursor in the Start Point (H: 25mm and V: 37mm) desired fields and key in the desired values. End Point (H: 25mm and V: 7mm)

Second Point (R: 15.5mm)
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The three point arc appears as shown here:
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Creating Splines
This task shows you how to create a spline and then modify the spline control points (coordinates or clicking).

Creating a spline

1. Click the Spline icon Profiles toolbar.

from the

2. Click in the geometry to indicate the points through which the spline goes. 3. Double-click the last point you have created to finish the spline creaton. (Clicking again on the Spline icon or another command also ends the spline creation.)

At any time when creating a spline, you can close it by right-clicking the last point and selecting Close spline from the contextual menu.
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The spline is closed in such a way that it is continuous in curvature.

•

Keep in mind that using the displayed Sketch tools toolbar also allows creating a spline. In addition, two constraints will be created (H and V).

Modifying the spline control points
1 . Double-click the control point you wish to edit.
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The Control Point Definition dialog box appears. 2. Enter new coordinates. For example, v: 9mm (vertical). 3. Check the Tangency option to impose a tangency on this control point. You can invert the tangent direction clicking the Reverse tangent button. 4. Click OK.

The point is moved and an arrow appears on this point to indicate a tangency.

You can also check the Curvature option to activate the Curvature editor and impose a curvature on the previously selected control point.

Keep in mind that selecting a point then dragging it will modify the spline shape. Tangents can be constrained.

Connecting Curves
Connecting Curves with a Spline
This task shows you how to connect two elements of the curve type, using a connecting curve (a spline) that goes through their end points.
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A connecting curve is associative, and it can be continuous in point, in curvature or in tangency with its support curves. You can define the tension value and the direction of the continuity at each connecting point, as well as add constraints to the connecting curve. Moving a connecting curve will change the shape of the support curves accordingly. Open the Connect_Curves.CATPart document.

1. Click the Connect icon: The Sketch tools toolbar now displays connection and continuity options for defining the connection:

Connection options are: • • Connect with an Arc: Connect with a Spline:

Connect with a Spline is selected by default. Continuity options are (available with Connect with a Spline option only): • • • Continuity in point: Continuity in tangency: Continuity in curvature:

Continuity in curvature is selected by default. Tension value corresponds to a multiplying coefficient applied to the tangent vector norm (available with Continuity in tangency and Continuity in curvature options only). The default value is 1 and the 0 value corresponds to a continuity in point. 2. Select the first spline to be connected.
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3. Select the second spline to be connected.

Locations where you click to select the first and the second element are important: the closest point to where you click will be automatically used as the starting point and the end point of the connecting curve. Always click close to the point you want to connect, or click the point itself. A connecting spline appears: it is continuous in curvature to both selected elements.
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4. Click the Connect icon: 5. Select the Continuity in point option: 6. Select the first spline to be connected.

7. Select the second spline to be connected.
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A connecting spline appears: it is continuous in point to both selected elements.

• • •

You can edit the connecting curve, as well as add constraints to it. See Editing Connecting Curves. You can also move the connecting curve: in this case, the shape of the support elements will change accordingly, as shown here for example. You cannot trim or break a connecting curves.
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Connecting Curves with an Arc
This task shows you how to connect two elements of the curve type using an arc. Open the Connect_Spline.CATPart document. 1. Click the Connect icon from the Profile toolbar (Spline subtoolbar).
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The connect options appear in the Sketch tools toolbar. By default, the Connect with a Spline option is active, and its related options are displayed.

2. Click the Connect with an Arc option . 3. Select a first element to connect (starting point), and then a second element (ending point).

The point on which you click to select the first and the second element is important: the closest point to where you click will be used as the starting point and the end point of the connecting curve. Always click close to the point you want to connect, or click the point itself. A connecting arc appears, tangent to both selected elements.

Creating Standard Curves
Creating Ellipses
This task shows how to create an ellipse (made of two infinite axes). In this task, we will use both the Sketch tools toolbar and clicking. In other words, you will move the cursor to activate SmartPick and click as soon as you get what you wish. 1. Click the Ellipse icon the Profiles toolbar. from
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The Sketch tools toolbar displays values for defining the ellipse center point, major and then minor semi-axis endpoint. 2. Position the cursor in the desired fields and key in the desired values. Center

For example, enter H: 9mm and V: 8mm. Note that you can also click to create a first point that corresponds to the ellipse center.

Major Semi-Axis Endpoint

For example, enter H: 65mm and V: 8mm. You just created a point on the ellipse. This point allows defining the major semi-axis.
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Creating a Parabola by Focus
This task shows you how to create a Parabola by Focus by clicking the focus, apex and then the parabola two extremity points. 1. Click the Parabola by Focus from the Profiles icon toolbar (Conic subtoolbar).
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Focus:

2. Click to define the parabola focus and apex.

Apex:
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3. Click two points that correspond to the parabola end points. Second Point:

The parabola results as shown here:

Creating a Hyperbola by Focus
This task shows you how to create a hyperbola by clicking the focus, center and apex, and then the hyperbola two extremity points.
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Focus: Once you click, the focus is symbolized by a cross ( ).

2. Click to define the hyperbola focus, center and apex.

Center (asympote intersection): The center is not associative to the hyperbola.

Apex:
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First Point:

3. Click two points that correspond to the hyperbola end points.

Second Point:
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The hyperbola results as shown here:

Note that, you can use the Sketch tools toolbar for defining the excentricity of the hyperbola.

Creating Conic Curves
This task shows the different methods you can apply to create conic curves which are either arcs of parabolas, hyperbolas or ellipses. The Sketch tools toolbar displays options for defining the conic:

•

Conic creation type options are:

Two Points type allows you to create a conic from two points (the start and end points), two tangencies at these points and either a parameter or a passing point. This type is activated by default. See Using Two Points and Start and End Tangent and Using Two Points and Tangent Intersection Point. Four Points type allows you to create a conic from four points (the start and end points, and two intermediate passing points) and one tangency at one of these points. Intermediates passing points have to be selected in logical order. See Using Four Points with a Tangency at Passing Point.
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Five Points type allows you to create a conic from five passing points (the start and end points, and three intermediate passing points). You cannot define a tangency at any of these point. Intermediates passing points have to be selected in logical order. See Using Five Points. • Conic creation mode options are:

Nearest End Point allows you to create a conic based on existing curved. If the selected points belong to a curve the tangent direction is directly read on the curve. This mode is activated by default. See Using Two Points with the Nearest End Point Mode. Start and End Tangent mode allows you to define: • • The tangencies at start and end points for Two Points type. For Two Points type, this mode is activated by default, see Using Two Points and Start and End Tangent. The tangency at one point only for Four Points type, if you deactivate this mode for the three first created points, a tangency must be automatically defined for the last point. Each time you redefine a tangency at one point, the previous defined tangency is removed, see Using Four Points with a Tangency at Passing Point. For Four Points type, this mode is activated by default.

This mode is available with Two Points and Four Points types only, and for these types activated by default. Tangent Intersection Point mode, available with Two Points type only, allows you to define the intersection point of the start and end tangents. The start and end tangents are defined from this point and the start and end points respectively. This mode deactivates the Start and End Tangent mode. See Using Two Points and Tangent Intersection Point. • • • A new conic feature will appear in the specification tree. The conic is variational and associative with the geometrical inputs, which means that it will be updated after every modification of a geometry input. You can also edit the curve or add constraints to it.

Enter the Sketcher workbench.

Using Two Points and Start and End Tangent
1. Click the Conic icon:
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2. Select the Two Points type: 3. Click to indicate the start point: H=20mm, V=20mm

4. Type in the Sketcher tools toolbar for the start tangent point: H=30mm, V=50mm and press Enter.

The start point and tangent have been created.
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5. Click to indicate the start point: H=90mm, V=10mm

6. Type in the Sketcher tools toolbar for the end tangent point: H=70mm, Angle=120deg and press Enter.

With a Parameter

The parameter value is a ratio ranging from 0 to 1 (excluded), this value is used to define a passing point: • • • If parameter = 0.5, the resulting curve is a parabola. If 0 < parameter < 0.5, the resulting curve is an arc of ellipse. If 0.5 < parameter < 1, the resulting curve is a hyperbola.

7. Type in the Sketcher tools toolbar for the parameter: Parameter=0.3 and press Enter.

The conic is created.
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With a Passing Point

6. Type in the Sketcher tools toolbar for the parameter: H=50mm, V=40mm and press Enter.

The conic is created.

Using Two Points and Tangent Intersection Point
1. Click the Conic icon:
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2. Select the Two Points type: 3. Select the Tangent Intersection Point mode: 4. Click to indicate the start point: H=20mm, V=20mm

5. Click to indicate the end point: H=90mm, V=10mm

6. Click to indicate the tangent intersection point: H=60mm, V=60mm
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With a Parameter

The parameter value is a ratio ranging from 0 to 1 (excluded), this value is used to define a passing point: • • • If parameter = 0.5, the resulting curve is a parabola. If 0 < parameter < 0.5, the resulting curve is an arc of ellipse. If 0.5 < parameter < 1, the resulting curve is a hyperbola.

7. Type in the Sketcher tools toolbar for the parameter: Parameter=0.3 and press Enter.

The conic is created.
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With a Passing Point

6. Click to indicate the passing point: H=50mm, V=40mm The conic is created.

Using Two Points with the Nearest End Point Mode
1. Create two lines, the first between H=10mm, V=0mm and H=40mm, V=60mm, and the second between H=90mm, V=0mm and H=90mm, V=40mm
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2. Click the Conic icon: 3. Select the Two Points type: 4. Select the Nearest End Point mode: 5. Click to indicate the start point: H=20mm, V=20mm

6. Click to indicate the end point: H=90mm, V=10mm
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7. Click to indicate the passing point: H=60mm, V=40mm

The conic is created: • • The tangents at the start and end points have been defined by the lines. The start and end points taken into account are the nearest extremities of the lines during the selection.
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When you redo the previous steps deactivating the Nearest End Point mode: • • The tangents at the start and end points have been defined by the lines. The start and end points taken into account are the selected points on the lines.

Using Four Points with a Tangency at Passing Point
1. Click the Conic icon:
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2. Select the Four Points type: 3. Click to indicate the start point: H=20mm, V=20mm

4. Type in the Sketcher tools toolbar for the start tangent point: H=30mm, V=50mm and press Enter.

The start point and tangent have been created.
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5. Click to indicate the start point: H=90mm, V=10mm

6. Select the Start and End Tangent mode: 7. Click to indicate the first passing point: H=60mm, V=50mm

8. Type in the Sketcher tools toolbar for the first tangent point: H=90mm, V=50mm and press Enter.
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9. Click to indicate the second passing point: H=100mm, V=40mm

The conic is created. The defined tangent at the start point has been released and the construction line representing the tangent has been removed.

Using Five Points
1. Click the Conic icon: 2. Select the Five Points type:
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3. Click to indicate the start point: H=20mm, V=20mm

4. Click to indicate the end point: H=90mm, V=10mm

5. Click to indicate the first passing point: H=30mm, V=50mm
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6. Click to indicate the second passing point: H=60mm, V=50mm

7. Click to indicate the third passing point: H=60mm, V=50mm
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The conic is created.

Creating Standard or Construction Elements
This task shows how to create standard elements or construction elements. Note that creating standard or construction elements is based upon the same methodology. If standard elements represent the most commonly created elements, on some occasions, you will have to create geometry just to facilitate your design. Indeed, construction elements aim at helping you in sketching the required
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1. Click the command from theSketch tools toolbar so that the elements you are now going to create be either standard or construction element. In this task, you will transform the newly created elements into construction elements.

As construction elements are not taken into account when creating features, note that they do not appear outside the Sketcher.

Here is an example of the use of both types of elements. The hexagon was sketched using three construction circles:

This type of sketch is interesting in that it simplifies the creation and the ways in which it is constrained. Setting a radius constraint on the second circle is enough to constrain the whole hexagon. Just imagine what you would have to do to constrain hexagons sketched with no construction circles!

Standard or Construction Points
Points are represented either by crosses or just by points, depending on the chosen creation mode. • • In standard mode, which is the default mode, points created on a line, for instance, are represented by crosses. The points and the line are visible outside the Sketcher workbench. Points generated by Break operations are created in construction mode, button is set to Standard. These even if the Standard/Construction points are not visible outside the Sketcher workbench.

Creating Lines
Creating Lines
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This task shows how to create a line. In this task, we will use the Sketch tools toolbar but, of course you can create this line manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. Enter the Sketcher workbench.

1. Click the Line icon: The Sketch tools toolbar now displays values for defining the line. 2. Type in the Sketcher tools toolbar for the start point: H=18mm, V=18mm and press Enter.

3. Type in the Sketcher tools toolbar for the end point: L=30mm, A=45deg and press Enter.

The line is created. Constraints are similarly assigned to this line on the condition you previously activated the Dimensional Constraints option 4. Double-click to edit the angle constraint. The Constraint Definition dialog box appears. in the Sketch tools toolbar.
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5. Set the new angle Value to 30deg and click OK.

Care when you assign graphical attributes to a line (for example, make it thick and red). When you turn this red thick line into a construction line (from the contextual menu: Object.Line -> Definition..., Construction line option in the Line Definition dialog box), the line will become a dotted gray line. Even though you then decide to make it a standard line back again (un-checking the Construction line option), the "red" and "thickness" attributes will not be assigned to the line. The line will be assigned its original attributes (white).

Defining Line Length/Angle Parameters
Once you have created one line, you can create any other and in the meantime use the length from the line first created or set this first line as an angle reference. For this: 6. Click the Line icon: 7. Right-click the first line and select Parameter -> Copy Length from the
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contextual menu. 8. Click to indicate the start point location.

9. Click to indicate the end point location.

The new line is created with a length of 30mm.
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10. Click the Line icon: 11. Right-click the first line and select Parameter -> Set As Angle Reference from the contextual menu. A red arrow symbolizing the reference orientation for the angle is displayed on the first line.

12. Type in the Sketcher tools toolbar for the angle line: A=75deg and press Enter.
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13. Click to indicate the start point location.

14. Click to indicate the end point location.

The new line is created with an angle of 75deg in relation to the first line reference orientation.
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Creating an Infinite Line
This task shows how to create an infinite line either horizontal or vertical, or still according to two points you will specify using SmartPick.

1. Double-click the Infinite Line from the icon Profile toolbar (Line subtoolbar). The following options appear in the Sketch tools toolbar. The Horizontal Line option is the default option.
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If you keep the Horizontal Line option active, as you go over the viewer with the cursor, an horizontal line automatically appears. 2. Click to position the line.

3. Activate the Vertical Line option from the Sketch tools toolbar.

As you go over the viewer with the mouse, a vertical line now automatically appears. 4. Click to position the line.

5. Activate the Line Through Two Points option from the Sketch tools
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6. Click to position a start point on the infinite line to be created.

7. Click to position an end point on the infinite line to be created.
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Creating a Bi-Tangent Line
This task shows how to create a bi-tangent line by creating two tangents (on two different elements). Create two circles.

1. Click the Bi-Tangent Line icon from the Profiles toolbar (Line subtoolbar).

2. Click a first element (first tangent). For example, click a circle.

3. Click a second element (second tangent). For example, click another circle. The bi-tangent line appears between both selected elements. The bi-tangent line appears as well as the corresponding constraints provided you activated the Geometrical Constraints icon .

Tangents are created as close as possible to where you clicked on the circle.
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At this step, create a point. At any time, you can select a point type element. The line will go through this point and a coincidence constraint is created on this point.

Creating a Line Normal to a Curve
This task shows how to create a line normal to a curve. As a perpendicularity constraint is created, the line remains perpendicular to the curve even when it is moved. Create a spline. 1. Click the Line Normal to Curve from the icon Profile toolbar (Line subtoolbar).

2. Click the line first point.
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The line is created, as well as a perpendicularity constraint (between the line and the curve).

Lines normal to a curve are created as close as possible to where you clicked on the curve. You will get better results if, before clicking the curve, you try to position the line as perpendicular to the curve as possible.

Creating a Bisecting Line
This task shows how to create an infinite bisecting line by clicking two points on two existing lines.

Open the Line_Bisecting.CATPart document. 1. Double-click the Bisecting Line from the icon Profiles toolbar (Line subtoolbar).
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2. Click two points on the two existing lines, one after the other.
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The infinite bisecting line automatically appears, in accordance with both points previously clicked.

Note that this bisecting line corresponds to a line symmetrically constrained to two lines (of course on the condition the Geometrical Constraint option is active in the Sketch tools toolbar). If both selected lines are command parallel to each others, a new line will be created between these lines.

Creating an Axis
This task shows how to create an axis. You will need axis whenever creating shafts and grooves. Axis cannot be converted into construction elements. Enter the Sketcher workbench.

1. Click the Axis icon: 2. Click to indicate the start point: H=20mm, V=10mm
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3. Click to indicate the end point: H=20mm, V=50mm

The axis is created.
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•

•

You can create only one axis per sketch, if you try to create a second axis, the first axis created is automatically transformed into a construction line. If before you start the Axis command, you have already selected a line, this line will automatically be transformed into an axis.

Creating Points
Creating Points
This task shows you how to create a point. In this task, we will use the Sketch tools toolbar but, of course you can create this point manually. For this, move the cursor to activate SmartPick and click as soon as you get what you wish. Enter the Sketcher workbench.

1. Click the Point icon: The Sketch tools toolbar now displays values for defining the point. 2. Type in the Sketcher tools toolbar for the start point: H=18mm, V=18mm and press Enter.
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The point is created. Constraints are similarly assigned to this point on the condition you previously activated the Dimensional Constraints option Sketch tools toolbar. 3. Double-click to edit the 19.7mm offset constraint. The Constraint Definition dialog box appears. in the

4. Set the offset Value to 20mm and click OK.

For creating an isobarycenter, click (or multi-select) at least two points before clicking the Point command. Note that an isobarycenter can only be created between points. In other words, if you multi-select a
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rectangle, the four points of this rectangle, and only these four points, will be used for defining the isobarycenter. Associativity is no more valid.

Symbols Representing Points
Points are represented either by crosses or just by points, depending on the chosen creation mode. • In standard mode, which is the default mode, points created on a line, for instance, are represented by crosses. The points and the line are visible outside the Sketcher workbench. Points generated by Break operations are created in construction mode, even if the Standard/Construction button is set to Standard. These points are not visible outside the Sketcher workbench.

•

Creating Points Using Coordinates
This task shows you how to create a point by indicating coordinates. In this task, we will use an existing point as reference for creating another point. Enter the Sketcher workbench.

1. Click the Point icon: 2. Click to indicate the end point: H=20mm, V=20mm 3. Click the Point by Using Coordinates icon:

The Point Definition dialog box appears. This dialog box allows you to use either cartesian (h and v) or polar coordinates. 4. Select the previously created point.
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5. Select the Polar tab in the Point Definition dialog box and type in the fields: Radius=30mm, Angle=30deg The point is created with a 30mm radius and 30deg angle relatively to the reference point. A construction line represents the angle direction.

The symbol used for points in the geometry area can be customized. For this, right click and select the Properties option from the contextual menu (Graphic tab).

Creating Equidistant Points
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This task shows how to create a set of equidistant points on a line. You can create equidistant points on curves. Open the Sketcher_02.CATPart document.

1. Click the Equidistant Points icon: 2. Select the line.

The Equidistant Points Definition dialog box appears. By default 10 equidistant New Points are previewed.
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The Reverse Direction button allows you to create the equidistant points in a reverse direction. 3. Select one of the extremity points of the line as starting point.

The Parameters and Spacing fields automatically become editable. By default, the Points & Spacing parameter option is displayed.
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4. Set New Points=2 and Spacing=25mm

• •

If you use the spinners to modify any value, the point distribution is automatically updated. If you type a value in a field, you have to press the Enter key to update the point distribution.

The spacing value represents the distance between two consecutive new points. 5. Press Enter if needed. Two points are displayed and distributed along the line.
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6. Select Points & Length in the Parameters combo. 7. Set Length=60mm

The length value represents the distance between the starting point and the last new point created. 8. Press Enter if needed. The point distribution is modified.
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9. Select Spacing & Length in the Parameters combo. 10. Keep Spacing=20mm and set Length=90mm According to these values, 3 new points will be created.

11. Press Enter if needed. Three new points are now displayed, but the point distribution is not modified.
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12. Click OK. The points are created with their constraints and associated formulas.

•

Constraints are similarly assigned to these points and distribution on the condition you previously activated the Dimensional Constraints option and the Geometrical

• •

in the Sketch tools toolbar. Constraints option Formulas can be created. For more information about formulas, see Knowledge Advisor User's guide. You can edit points one after the other. For this, double click one point and redefine either the Cartesian or the polar
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•

coordinates from the Point Definition dialog box that appears. Modifications applied to the supporting element are not applied to points. The symbol used for points in the geometry area can be customized using the Edit -> Properties command (Graphic tab).

Creating Points Using Intersection
This task shows you how to create one or more points by intersecting curve type elements. Open the Intersection_Point.CATPart document.

1. Multi-select the elements to be used for intersecting.

2. Click the Intersection Point icon from the Profiles toolbar (Point sub-toolbar).

3. Select one curve type element with which the elements first selected will intersect and on which intersection points will be created.
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The intersecting points automatically appear on the curve type element last selected.

The constraints appear, of course on the condition the Geometrical Constraint option command is active in the Sketch tools toolbar).

Creating a Point Using Projection
This task shows you how to create one or more points by projecting points onto curve type elements. Open the Projection_Point.CATPart document. 1. Multi-select the elements to be used for projection.

To multi-select several elements you have two possibilities either: • use the control key before selecting the command.
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•

drag the cursor if the command is already activated.

2. Click the Projection Point icon: 3. Select one curve type element on which the element first selected will be projected and on which projection points will be created.

The projection points automatically appear on the curve type element last selected, as well as construction lines.

•

The constraints appear, of course on the condition the is active in the Geometrical Constraint option command Sketch tools toolbar). The points that are projected are perpendicular to the element last selected provided this element is a line. Note that both the selected points and the projected points are associative with the construction lines that are also created. A construction line is created between the original points and the projected ones.

•

•

Creating Associative Projected Points
1. Create a spline and points.
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2. Click the Projection Point icon: The Sketch tools toolbar now displays values for defining the projection mode. Two projection mode options are available: • • Orthogonal Projection: Projection Along a Direction:

Orthogonal Projection is the default mode.
Orthogonal Projection

3. Select the Orthogonal Projection option: 4. Select several points. 5. Select the spline.

All the selected points have been projected onto the curve according to a normal direction at this curve.
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Projection Along a Direction

3. Select the Orthogonal Projection option: 4. Select one point. 5. Select the spline.

The selected point is projected along the given direction.
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SmartPick
Using SmartPick
You can work with a higher productivity by using the available Smart Pick cursor.

Before you Begin: You should be familiar with important concepts. SmartPicking a Point: Specify a location either for you to create geometry or for SmartPick to return information via symbols. Creating Geometry Using SmartPick: Position geometry to be created according to existing geometry, if needed, and to internal parameters.

Before You Begin
What is SmartPick ?
SmartPick is a smart and easy-to-use positioning tool which will assist you when using most of the commands for creating Sketcher geometrical elements. SmartPick will give you higher productivity by decreasing the number of the interactions necessary for positioning these geometrical elements. According to the various active options (Tools->Options->Sketcher from the menu bar), you can create the geometrical constraints that are equivalent to the snapping you performed. SmartPick will return information via symbols. To do this, SmartPick uses the four following sources of information:

3D graphic window and SmartPi ck cursor:

Sketch tools toolbar (Coordinates and parameters):
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Contextual menu:

Ctrl or Shift keys.

Specifying a Location
Using SmartPick, you will easily specify a location: • • • • • • • • • • • somewhere on the grid using coordinates on a point at the extremity point of a curve at the midpoint of a line at the center of a circle or an ellipse all over a curve at the intersection point of two curves aligned at a vertical/horizontal position on the fictitious perpendicular line through a line end point any of the above cases possibly combined together, whenever possible.

You will progessively specify this location by providing information using as above mentioned the blue cursor, coordinates, the contextual menu and Shift/Ctrl keys. Of course, as you will specify your needs, you will shorten the scope of the available possibilities for eventually locating the elements as desired. Note that if you position the cursor outside the zone that is allowed for creating a given element, the symbol appears.

SmartPicking
This task shows you how to specify the location of given geometry thanks to information that SmartPick returns via symbols. In other words, SmartPick returns feedback information (highlighted geometry or symbols) which you will or will not validate. You will also learn how to progressively specify your needs using the blue cursor, the Sketch tools toolbar, the contextual menu, Shift key or Ctrl key. When you move the cursor, H and V corresponding coordinates appear on
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the screen and also in the Sketch tools toolbar. Note that the coordinate at the top is H and the coordinate at the bottom is V.

SmartPicking Somewhere On the Grid
SmartPick displays the SmartPick blue cursor. The SmartPick blue cursor can be snap to the grid according the Snap to Point option from the Sketch tools toolbar. This option is also available in the Sketcher settings, see Snap to point option. SmartPick blue cursor is at the grid intersection point and far from the cursor, Snap to Point option activated:

SmartPick blue cursor is close to the cursor, Snap to Point option deactivated:

SmartPicking Using Coordinates
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As you move the cursor and try to assign the desired position to the SmartPick cursor, the Sketch tools toolbar similarly displays the corresponding horizontal and vertical coordinates of SmartPick blue cursor. You can use the Sketch tools toolbar fields for defining the point coordinates either independently from each others or not. For example, enter H: 2mm SmartPick is locked on this value. As you move the cursor the V coordinate appears in the Sketch tools toolbar.

If you want to reset H or V coordinates you just entered in the Sketch tools toolbar, display the contextual menu (right-click on the background) and select the Reset command.

SmartPicking Hiding Coordinates
Unselect the Visualization of the cursor coordinates option in the Sketcher settings, see Visualization of the cursor coordinates option. The cursor coordinates are automatically hidden as you move the cursor within the geometry area.
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SmartPicking On H and V Axes
As you move the cursor and try to assign the desired position to the SmartPick cursor, a horizontal fictitious blue dotted line appears when v is equal to zero, a vertical fictitious blue dotted line appears when h is equal to zero.

SmartPicking On a Point
When a point is included in the tolerance zone of SmartPick cursor, SmartPick first snaps to the point and the point-to-point coincidence symbol appears.
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This symbol means that snapping suppresses both degrees of freedom available for a point.

SmartPicking At a Curve Extremity Point
When a fictitious curve extremity point is included in the tolerance zone of SmartPick cursor, SmartPick snaps to the extremity of this curve. The point-to-point coincidence symbol appears once the point is picked.

Be careful: by default, all the curves are assigned fictitious extremity points. This is why, and as you will probably expect, SmartPick detects first point-topoint coincidence with the curve existing end point. Care that in this case only the extremity point is highlighted whereas in the previous case the whole line is highlighted.
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You can also use the contextual menu (Nearest End Point option) while going over any curve type element with the cursor, and detect first point-to-point coincidence with the curve existing end point.

SmartPicking At the Midpoint of a Line
When the midpoint of a line is included in the tolerance zone of SmartPick cursor, SmartPick snaps to the midpoint of this line. The point-to-point coincidence symbol appears once the midpoint is picked and the line highlights.
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For this, you can also use the Midpoint command from the contextual menu.

SmartPicking At the Center of a Circle
When the fictitious center of a circle is included in the tolerance zone of SmartPick cursor, SmartPick snaps at the center of this circle. The point-topoint coincidence symbol appears once the circle center is picked and the circle highlights. For this, you can also use the Concentric command from the contextual menu on the circle.

Be careful: by default, circles are created with a center point, . As a result, SmartPick detects first point-to-point coincidence.

SmartPicking All Over a Curve
When a curve is included in the tolerance zone of SmartPick cursor, SmartPick automatically snaps to the curve which highlights. The curve coincidence symbol appears as you go all over the curve with the cursor. This symbol means the point is snapped and that there is still one degree of freedom left, except when two curves are detected at the same time. This is also true In the case of curves that can be extrapolated, (segments,
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arcs of circles, re-limited splines or conic curves). SmartPick will snap to these curves on the condition they are included in the tolerance zone of SmartPick cursor. For this, select the Support lines and circles option, see SmartPick options.

Any problem for detecting coincidence? Use the Ctrl key as is: 1. Go over the element to be made coincident. For example, a line. 2. Press and hold down the Ctrl key. SmartPick cursor remains positioned on the picked element. 3. Move the cursor wherever you want.

For more details on the Ctrl key, see Creating Geometry Using SmartPick.

SmartPicking At the Intersection Point of Two Curves
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When the intersection point of two curves is included in the tolerance zone of SmartPick cursor, both curve-type elements highlight. The coincidence symbol appears and SmartPick cursor snaps to the intersection.

This type of detection illustrates SmartPick main functionality: combined detection. In fact, when two snapping can possibly be performed, SmartPick aims at satisfying both of them by trying to snap them at the same time. This smart behavior is a global behavior and is valid for any kind of detection recognized by SmartPick. Any problem for detecting intersection? Use the Ctrl key as is: 1. Go over the element to be made coincident. For example, a line. The coincidence symbol appears to indicate that SmartPick snaps over the line.
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2. Press the Ctrl key. SmartPick automatically remains snapped whatever the position you assign to the cursor.

3. As you press the Ctrl key, go over the second element to be intersected with the element already picked using the cursor. When SmartPick detects that the second line can possibly be snapped to, SmartPick tries to combine both snappings detected thanks to the Ctrl key. In this particular case, SmartPick snaps at the intersection of both lines.

on Fictitious Perpendicular Line Through Line End Point
If the tolerance zone of SmartPick cursor goes over a fictitious perpendicular line that goes through the extremity point of a line, SmartPick snaps in order to remain on this fictitious perpendicular line. Make sure you selected the Alignment option, see SmartPick options. You will
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thus automatically detect the different elements along which the sketch is aligned.

SmartPicking At a Vertical/Horizontal Position
If the tolerance zone of SmartPick cursor crosses a fictitious horizontal line that would go through a point, SmartPick snaps in order to remain horizontal to this point.

In this case, no constraint is created. Make sure you selected the Alignment option, see SmartPick options. You will thus automatically detect the different elements along which the sketch is aligned.

Creating Geometry Using SmartPick

Using SmartPick, you will adapt the way you use the Sketcher so as to position geometry to be created according to existing geometry, if needed, and to internal parameters. As a result, you w use commands in accordance with the type of the element to be created: one command per elem Unlike CATIA Version 4 (general 2D and 3D creation commands), to create one element, you no longer need to activate a group of specific commands (or creation scheme).

From Scratch

You can create geometrical elements by progressively specifying a given number of characteristic points. These characteristic points can be specified whatever the active Sketcher command.
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Characteristic points are pre-determined fictitious points managed by SmartPick which allow crea and manipulating geometrical elements whatever the complexity of the latter.

You will create some of these characteristic points with total freedom (both horizontal and vertica degrees of freedom are available ), and others with partial freedom (only one degree of freedom available ).

You will find here below a non-exhaustive list with Sketcher elementary geometrical elements and corresponding characteristic points. SmartPick lets you position these points using one of the following: the cursor, the Sketch tools toolbar, the contextual menu, Shift or Ctrl key.

A line

An arc (center radius)

An arc of a circle using thr points

An oriented rectangle

A circle

A parabola

The order in which the above mentioned characteristic points ( 1 , 2 , 3 , 4 ) will be specified can be modified. Still, you can choose the means to be used for positioning these points, as long as y exclusively take into account: • • • •

positioning specifications (SmartPick cursor) external geometry (for example, two lines parallel to each others, or two coincident points internal geometry characteristics (horizontal/vertical lines, quarter of arc of circles) the externalized parameters of a geometrical element (length, angle, excentricity and so f

According to Existing Geometry
Reference Geometry
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SmartPick finds out geometrical specifications according to geometrical elements that already exi a sketch.

You will only detect geometrical specifications according to the current sketch elements that are visible in the 3D window in which the cursor is positioned. You will not need to perform any intera and you will be returned a visual feedback as shown below in a non exhaustive way:

parallel (two lines)

tangent (a line and a circle)

perpendicular (two lines)

tangent (two circles)

concentric (a circle and an arc)

coincident (curve through point on line

Consequently, when detecting a constraint, detection can result ambiguous. To remove this ambiguity, you can try to move the viewpoint so that the elements that imply ambiguity would disappear.

As you will see when using SmartPick, snapping ambiguities currently occur. Besides, the dimens specifications of a part often depend on technological specifications. These dimensional specificat are defined as the part is being designed, they depend on the current application area and are, as result, very hard to guess for SmartPick tool. In order to solve these ambiguities, SmartPick class possible snapping according to the geometrical constraints that are associated to these snapping. such, a given cursor positioning will be only assigned one snapping. Unfortunately, this classificat cannot be modified. It is provided in the table below. Constraints Decreasing Priority Order 1. Point-to-point coincidence 2. Point-to-extremity point coincidence 3. Point-to-noticeable point coincidence (for example, the
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midpoint of a line) Curve-to-curve tangency Horizontal or vertical line, or else a quarter of an arc of a circle Parallelism Perpendicular curves Point-to-curve coincidence Curve-to-curve coincidence or point to curve support coincidence 10. Point on a perpendicular line through a line end point 11. Point at a vertical position 12. Point at a horizontal position 4. 5. 6. 7. 8. 9.

Also to remove ambiguity during elements creation, the three options which are parallelism, perpendicular and tangency can be activated independently from each other. See SmartPick optio

In addition to this classification, when several snapping are possible for a given type of geometric constraint, SmartPick takes into account the distance between the snapped cursor and the geometrical element according to which the snapping is possible. In this case, SmartPick snaps to nearest element.

Still, there are some cases when SmartPick does not allow dimensioning as desired without additi interactions. This is why SmartPick therefore manages two means for applying a particular snapp relatively to the geometrical elements.

Forcing the Snapping
SmartPick allows forcing the snapping on a given geometrical element using either the contextua menu or the Ctrl key.
Contextual Menu

SmartPick allows forcing the snapping on a given geometrical element using the contextual menu will avoid ambiguities linked to the automatic detection of elements in the current 3D viewpoint b forcing: • snapping detected at a distance: parallel, perpendicular, concentric, tangency and curve (line/circle) that goes through a point. At a distance means that these constraints are detected even though the cursor is not
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•

positioned on the reference element. snapping at a given position that is relative to a geometrical element: line midpoint, circle center. At a given position means that both degrees of freedom are locked.

The contextual menu is therefore available when right-clicking most Sketcher geometrical elemen Of course, the contents of the contextual menu depends of the element that is being currently created. This contextual menu can be made of the below four sub-parts: • • • •

Option that belongs to the Base Infrastructure product. Snapping the characteristic point that is being manipulated (see From scratch paragraph a table below). Snapping the geometrical element that is being created (see table below). Managing the parameters that are associated to the geometrical element that is being sketched.

Any snapping that is imposed via the contextual menu can be de-activated. For this, right-click in 3D window background and select the Reset option from the displayed contextual menu.

The table below lists the constraints that can be detected when snapping characteristic points wh are being manipulated, relatively to existing geometrical elements, and thanks to the contextual menu. Popped-up Geometry Line Circle Ellipse Curve Available Snapping Line midpoint Circle center Ellipse center Nearest end point

The table below indicates the possible snapping for geometrical element which are being created, relatively to existing geometry and thanks to the contextual menu.
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External Geometry Element currently created Point Line Point Line Circle Ellipse

Conic S

Center Center Midpoint Nearest end point Nearest end point Nearest end point

No

Ellipse
Example of snapping possibilities

No

No

In the example below, you can see the various snapping possibilities for a line that is being create (dotted line(s) in the example) relatively to the existing spline: 3 tangency possibilities and 2 perpendicularity possibilities. The point you right-click to display the contextual menu is used to determine which option will be offered in the contextual menu. So depending on where you click, will not be offered the same options.

Note that the software takes into account what has already been specified (in this example, the fi point of the line) to offer the various snapping options. For this reason, depending on the first poi the geometrical element that is being created, there may be cases in which no solution can be fou or in which the solution offered does not correspond to what you want. In such a case, try to righ click before and/or after the point you want the software to choose. If you try both ways, one sol at least should be found.
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Ctrl Key

SmartPick also allows forcing the current snapping on an element using the Ctrl key: • •

•

You can force SmartPick to remain snapped on an element whatever the position of the cu For this, you will press the Ctrl key while the geometrical snapping you want to force is ac (the element may be highlighted and symbols may appear) and keep the Ctrl key pressed This functionality is efficient if once the Ctrl key is pressed you can still move the cursor. I other words, Ctrl has no effect if the current snapping inhibits both degrees of freedom. Th often the case when given snapping combinations are possible (for example at the interse of two lines) or when the cursor is close to a given point (explicit or implicit as for example midpoint of a segment). The Ctrl key is very useful when the sketch includes many geometrical elements because SmartPick takes into account the distance between the cursor and the geometrical elemen
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This is the zone in which the line-circle tangency snapping (due to the circle proximity) has the fir priority.

Apart from this zone, either the tangency snapping is meaningless or it interferes with closest geometries or still with possible constraints that are assigned higher priorities (see table).
Shift Key

If SmartPick cannot solve an ambiguity and returns a snapping that you are not satisfied with, yo can de-activate SmartPick assistant by pressing the Shift key.

Be careful: it can happen that either the Shift or Ctrl key do not behave as specified in the paragr above. In fact, sometimes the viewer looses the focus (selection priority). You can then perform a local transformation to recover the focus: use the middle mouse button and manipulate the viewp You will thus recover the focus.
Detecting Internal Geometry Characteristics

Certain geometrical elements are assigned internal peculiar geometrical characteristics. For exam and as shown below, this is the case for horizontal/vertical lines and for quarters of arcs of circles When such an internal specification is found out by SmartPick, the color of the currently created geometrical element becomes blue.
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Managing Geometry Parameters

SmartPick also manages internal geometrical specifications such as a line length or a circle radius Indeed, these specifications (further called parameters) decrease available degrees of freedom of geometry characteristic point (refer to previous From Scratch paragraph). All these parameters a accessed through the Sketch tools toolbar which gathers all the available parameters that can be valuated for a given geometry creation command. Finally, while the SmartPick cursor moves, the Sketch tools toolbar displays the parameters value.

Listed below is a non exhaustive list of the possible looks of Sketch tools toolbar parameter sectio

Length and Angle to H axis are available for Lin creation command.

Radius, Start Angle to H Axis or Angular sector available for Arc Circle creation command.

Excentricity is available for Hyperbola creation command.

Note that it is always possible to reset a parameter that have been valuated in the Sketch tools toolbar. For this, use contextual sub-menu Reset option that is available on 3D viewer backgroun

Relation Between Parameters and Characteristic Points
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There exist a strong relation between the characteristic point of a geometrical element and some the parameters it supports. In fact, if a parameter value is modified by moving the cursor, it mea that the parameter is linked to the current characteristic point and consequently validating the po will modify the parameter status.

Indeed, as when valuated a characteristic point can no longer be modified, associated parameters frozen which is echoed by a grayed entry in the Sketch tools toolbar.

As an example, in Arc Circle creation command, when the arc start point is defined (at the sketch origin on this picture) both Radius and Start Angle to H Axis get frozen. Indeed, as the arc center necessarily previously defined, to impose arc start point leaves no ambiguity on the radius and th start angle of the sector.

Specific Parameters
Some parameters have a specific behavior. This behavior is common to all geometry creation commands that use these parameters. This is the case for Angle and Sector parameters.
Sector Parameter

This parameter is oriented so that no ambiguity is possible when defining an angular sector. In th standard units system, an angle range is from -360 to 360deg. Any other value is recomputed to range. Positive values are for direct sectors (you go from the start direction to the end one the sa way you go from H axis to V axis). Negative values are on the other end for reverse arcs (you go the start direction to the end one the same way you go from V axis to H axis).
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A direct angular sector

A reverse angular sector

Note that an angular sector cannot be identically equal to zero.
Angle Parameter

This parameter is also oriented, its range is from 0 to 360 deg. As a consequence, a -10 deg valu identically equivalent to a 350 deg value and a 0 deg value is definitely not equal to a 180 deg va

A fixed 30 deg angle value imposed to a line

Note that when this angle is fixed, the cursor position is restricted to the half of the sketch plane. Indeed, otherwis 30 deg angle would be equal to a 210 deg one which is excluded.

By default, angle value are computed relatively to H-Axis. This can be modified any time you wan define an angle value using the contextual menu Parameter section

When an angle value is available in the Sketch tools toolbar, any line that is contained in the curr sketch can be defined as the angle computation basis. To issue out orientation, a red arrow is displayed to show the reference line orientation. In this example, a 25 deg angle is set relatively existing line
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Copying Parameter Values

It is possible to copy some of parameters value from any existing geometrical element that can b defined with the same parameters. This functionality is available through the contextual menu Parameter section for length and radius parameters. Length can be copied from a line while radius from a circle or an arc.

Deactivating a Sketch
This task shows you how to deactivate (and then reactivate) a sketch as well as its related features (in order to avoid update errors). You will also learn how formulas let you view all activities and their status, as well as activate/deactivate activities. You can use the same method to deactivate absolute axes, projections, intersections. Open the Pinmounting.CATPart document. 1. From the specification tree, right-click Sketch.5.
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2. In the contextual menu which is displayed, select Sketch.5 object -> Deactivate. The selected sketch, and the elements which are impacted by its deactivation, are highlighted in the specification tree and in the geometry area. The Deactivate dialog box is displayed, listing the elements which are impacted by the sketch deactivation.
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User Tasks 3. Make sure that the Deactivate impacted elements option is checked in the dialog box: this ensures that there will be no update error when the sketch is deactivated. 4. Click OK to validate and close the dialog box. The selected sketch and the impacted elements are deactivated. Specific icons are displayed in the specification tree for deactivated element to indicate that they have been deactivated.

5. If you now click the Formula icon in the Knowledge toolbar to display the Formulas dialog box, you will be able to see that the Activity parameter corresponding to the selected item (Sketch.5, in this case) is set to "false" to indicate that this item is deactivated.
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6. To reactivate the sketch, you have two possibilities: • • In the Formulas dialog box, select the Activity parameter corresponding to the deactivated sketch (PartBody/Sketch.5/Activity), and select "true" from the Edit name or value of the current parameter drop-down list. From the specification tree, right-click Sketch.5, and select Sketch.5 object -> Activate from the contextual menu. The Activate dialog box is then displayed. Make sure the Activate impacted elements is checked if you want to reactivate the related features, and then click OK.

You can use either method to reactivate the sketch and the elements that were impacted by its deactivation. In some cases, not all impacted elements will be reactivated when you use the second method. In this case, you will be able to reactivate impacted elements individually.
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Workbench Description

This section contains the description of the workbench icons and menus. Many of these commands are discussed in greater details in other parts of the guide.
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Sketcher Menu Bar
This section presents the main menu bar and commands dedicated to the Sketcher. Start File Edit View Insert Tools Windows Help

Edit
For... Cut... Copy Paste Delete... See...

Deleting Sketcher Elements

xxx.object

Editing the Profile Shape and Size Editing Sketcher Elements

Insert
For... Constraint... Profile... Operation... See... Setting Constraints Sketching Profiles Performing Operations on Profiles

Tools
For... See...
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Toolbars
Sketch Tools Toolbar

See Working with the Grid Option See Snap to Point See Creating Standard or Construction Elements See Setting Constraints See Setting Constraints

See Creating Corners See Creating Corners (One Element Trimmed) See Creating Corners (No Element Trimmed) See Creating Corners (Standard Lines Trim)
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See Creating Corners (Construction Lines Trim) See Creating Corners (Construction Lines Not trimmed)

See Creating Chamfers with Both Elements Trimmed See Creating chamfers with One Element Trimmed See Creating Chamfers with No Element Trimmed See Creating Chamfer with Standard Lines Trimmed See Creating Chamfer with Construction Lines Trimmed See Creating Chamfers (Construction Lines Not trimmed)

See Trimming Elements With Both Elements Trimmed See Trimming Elements With One Element Trimmed See Trimming Multiple Elements

See Breaking and Trimming Elements See Closing Elements

See Creating Symmetrical Extensions
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Sketcher Toolbar

This toolbar is available from the Part Design workbench.

See Starting a Sketch See Starting a Sketch

Workbench Toolbar

See Creating a Pad

Constraints Toolbar

See Creating Constraints via a Dialog Box See Quickly Creating Dimensional/Geometrical Constraints See Creating a Contact Constraint See Fixing Elements Together See Auto-constraining a group of Elements See Animating Constraint See Edit Multi-Constraint
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Profiles Toolbar

See Profiles See Rectangles See Oriented Rectangles See Parallelograms See Oblong Profiles See Oblong Arcs See Keyhole See Hexagons See Lines See Infinite Line See Line Normal to a Curve See Axes See Basic Circles See Three Point Circles See Circles Using Coordinates See Tri-Tangent Circle See Ellipses See Parabola See Hyperbola See Conic See Basic Arcs See Arcs Three Point See Arcs Three Point via Limits See Splines
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See Connecting Curves with a Spline and Connecting Curves with an Arc See Bi-Tangent Line See Bisecting Line See Centered Rectangle See Centered Parallelogram See Points See Points Using Coordinates See Equidistant Points See Intersection See Projection Point

Tools Toolbar

See Cutting the Part by the Sketch Plane See Creating Datums See Creating Output Features See Creating Profile Features See Performing a Light Sketch Analysis See Analyzing the Sketch

Operation Toolbar

See Creating Corners (Both Elements Trimmed) See Creating Corners (One Element Trimmed) See Creating Corners (No Elements Trimmed)
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See Creating Chamfers with Both Elements Trimmed See Creating Chamfers with One Element Trimmed See Creating Chamfers with No Elements Trimmed See Trimming Elements See Breaking Elements See Breaking and Trimming See Moving Element by Symmetry See Creating Mirrored Elements See Translating Elements See Rotating Elements See Scaling Elements See Offsetting Elements See Projecting 3D Elements onto the Sketch Plane See Intersecting 3D Elements with the Sketch Plane See Projecting 3D Silhouette Edges

Visualization Toolbar

See Cutting the Part by the Sketch Plane See Working with the Usual Option See Working with the No 3D Option See Working with the Low Light Option See Hiding or Showing Constraints See Hiding or Showing Constraints See Hiding or Showing Constraints
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Sketcher
This page deals with Sketcher options in the following tab: • The Sketcher tab lets you set the sketcher options.
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